
Nikon Scan 4 Reference Manual

Read This First ........................................................................................2–11

Scanning Basics.............................................................................................6

Introduction ............................................................................................. 2–5

The Scan Window .................................................................................12–29

The Tool Chest ..................................................................................... 30–76

Preferences.........................................................................................77–105

Image Windows................................................................................106–126

Scan Index ........................................................................................ 128–131

Appendices ....................................................................................... 131–139

Getting Started .......................................................................................7–10

Nikon View ...............................................................................................127

Elements of Nikon Scan...............................................................................11



2Read This First — Introduction

IntroductionIntroduction
About This ManualAbout This Manual

Welcome to Nikon Scan!  Nikon Scan is used to control 
Nikon scanners from a computer.  It can be used to preview 
images and adjust scanner settings before scanning, giving 
the user control over advanced features supported by Nikon 
fi lm scanners, including:
• The Scan Image Enhancer automatically adjusts hue to 

produce images with clear contrast (9000 ED, 5000 ED, 
COOLSCAN V ED only)

• Digital ICE detects, analyzes, and automatically compen-
sates for scratches and dust

• Digital ROC digitally restores faded colors in old fi lm
• Digital GEM automatically corrects for fi lm grain, smooth-

ing pictures taken with high-speed fi lm
• Digital DEE reveals details in shadows of backlit and un-

derexposed shots and increases contrast in “washed-out” 
areas of highlights to produce natural-looking exposure 
(9000 ED, 5000 ED, COOLSCAN V ED only)

Nikon Scan also supports batch scanning and can be used 
to scan images directly into third-party applications such as 
Adobe Photoshop.

This manual has been written to guide the user through the 
process of scanning and enhancing images.  For informa-
tion on how to perform specifi c tasks, see the “Scanning 
Guide.”  For information on specifi c elements of the Nikon 
Scan interface, see “The Scan Window,” “The Tool Chest,” 
“Preferences,” and “Image Windows.”  For troubleshooting 
information and a glossary of imaging terminology, see the 
appendices.

Trademark InformationTrademark Information
Adobe and Acrobat are registered trademarks of Adobe Systems Inc.  
Apple, the Apple logo, Macintosh, and Mac OS are registered trade-
marks of Apple Computer, Inc.  Digital ICE4 AdvancedTM is Digital ICETM, 
Digital ROCTM, Digital GEMTM and Digital DEETM.  Digital ICE4 AdvancedTM 
are technologies developed by Applied Science Fiction.  Pentium is a 
trademark of Intel Corporation.  Microsoft and Windows are registered 
trademarks of Microsoft Corporation.  Radius, ColorMatch, and Press-
View are registered trademarks of miro displays, inc.  All other trade 
names mentioned in this manual or the other documentation provided 
with your Nikon product are trademarks or registered trademarks of 
their respective holders.
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  IllustrationsIllustrations
Save where otherwise noted, the illustrations in this manual show the 
menus and dialogs displayed when the SUPER COOLSCAN 5000 ED 
is used under Windows XP.  Illustrations from Mac OS X are included 
where operations for Windows and Macintosh versions differ.

  Background KnowledgeBackground Knowledge
This manual assumes familiarity with operations common to the Ma-
cintosh and Windows operating systems. Refer to the documentation 
provided with the operating system if in doubt concerning the meaning 
of any of the terms used here.

  Printing This ManualPrinting This Manual
To print this manual for ease of reference, select Print… from the Ado-
be Acrobat Reader File menu and specify the desired page range.

To make it easier to fi nd the information you need, the fol-
lowing symbols and conventions are used:

This icon marks notes, information that should be read 
before using Nikon Scan.

This icon marks tips, additional information that may 
be helpful when using Nikon Scan.

This icon indicates that more information is available 
elsewhere in this manual or in other documentation.

This icon marks cautions, information that should be 
read before use to prevent damage to the scanner.

Use the following buttons and links to navigate the manual:

Click to go back one page.

Click to return to the table of contents.

Click to go forward one page.

Click to go to the beginning of the section.TOP

Blue underlined text indicates a link to an-
other part of this manual or the World Wide 
Web.  Click the text to follow the link (note 
that a web browser and an Internet connec-
tion are required to link to the World Wide 
Web).

and/or
blue under-
lined text

  Life-Long LearningLife-Long Learning
As part of Nikon’s “Life-Long Learning” commitment to ongoing prod-
 uct sup port and ed u ca tion, con tin u al ly-updated information is avail able 
on-line at the following sites:
• For users in the U.S.A.:  http://www.nikonusa.com/
• For users in Europe:  http://www.europe-nikon.com/support
• For users in Asia, Oceania, the Middle East, and Africa:
  http://www.nikon-asia.com/
Visit these sites to keep up-to-date with the latest product in for ma tion, 
tips, an swers to fre quent ly-asked ques tions (FAQs), and gen er al advice 
on digital imaging and pho tog ra phy.  Ad di tion al information may be 
available from the Nikon rep re sen ta tive in your area.  See the URL below 
for contact in for ma tion: http://www.nikon-image.com/eng/

http://www.nikonusa.com/
http://www.europe-nikon.com/support
http://www.nikon-asia.com/
http://www.nikon-image.com/eng/
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System Requirements
Nikon Scan must be installed before the scanner can be used to scan images.  See the documentation provided with the 
scanner for complete installation instructions.  Before installing Nikon Scan, make sure that the computer satisfi es the fol-
lowing system requirements:

Windows

* More memory may be required depending on fi lm type, scan size, resolution, bit depth, the number of scans performed in each session, the 
fi lm holder or adapter used, and on whether Digital ROC, Digital GEM or Digital DEE is used.  A system with more than the minimum amount of 
memory is recommended.

† More free disk space may be required depending on the fi lm type and number of frames.  Nikon recommends having as much free disk space as 
possible when running Nikon Scan.

‡ Depending on the type of interface installed, USB will operate at high speed (USB 2.0 only; maximum transfer rate 480 Mbps) or full speed (USB 
1.1/USB 2.0; maximum transfer rate 12 Mbps).  Windows XP and Windows 2000 Professional computers with a USB 2.0 interface support high-
speed USB.  For more information, consult the manufacturer.

Additional information technical and support information may be available at the Nikon web sites listed in this manual (  3).

Video resolution 800 × 600 pixels or more with 16-bit color (High Color) or more.

Hard-disk space†
A minimum of 40 MB required for installation (200 MB recommended), with an additional 200 MB of free disk space avail-
able while Nikon Scan is running.

Miscellaneous CD-ROM drive required for installation.

RAM* 128 MB or more (512 MB or more recommended)

OS Preinstalled versions of Windows XP, Windows 2000 Professional, Windows Me, Windows 98 SE

Interface Built-in USB 1.1/USB 2.0 ports

CPU 300 MHz Pentium or better

USB‡ OHCI-compliant IEEE 1394 interface required.IEEE 1394
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Macintosh

* For the latest information on supported versions of Mac OS, see the Nikon web sites listed in this manual (  3).
† More memory may be required depending on fi lm type, scan size, resolution, bit depth, the number of scans performed in each session, the 

fi lm holder or adapter used, and on whether Digital ROC, Digital GEM or Digital DEE is used.  A system with more than the minimum amount of 
memory is recommended.

‡ More free disk space may be required depending on the fi lm type and number of frames.  Nikon recommends having as much free disk space as 
possible when running Nikon Scan.

** Depending on the type of interface installed, USB will operate at high speed (USB 2.0 only; maximum transfer rate 480 Mbps) or full speed (USB 
1.1/USB 2.0; maximum transfer rate 12 Mbps).  Mac OS X computers with a USB 2.0 interface support high-speed USB.  For more information, 
consult the manufacturer.  Users of Mac OS X whose computer is not equipped with USB 2.0 can install a RATOC PCIU3U USB 2.0 interface 
board (for more information, visit Ratoc Systems English-language web-site at http://www.ratocsystems.com/english/index.html).

†† The computer may fail to recover from sleep mode when a 5000 ED, COOLSCAN V, or COOLSCAN IV is connected via USB 2.0.  To prevent the 
computer from entering sleep mode, select System Preferences… from the Apple menu, open the “Energy Saver” pane (in Mac OS 9, select 
Energy Saver from the Control Panels sub-menu in the Apple menu), and set the Put system to sleep whenever it is inactive for slider to 
Never.

Additional technical and support information may be available at the Nikon web sites listed in this manual (  3).

Video resolution 800 × 600 pixels or more with 16-bit color (thousands of colors) or more.

Hard-disk space‡
A minimum of 70 MB required for installation (200 MB recommended), with an additional 200 MB (Mac OS 9) or 550 MB 
(Mac OS X) of free disk space available while Nikon Scan is running.

Miscellaneous CD-ROM drive required for installation.

RAM†
• Mac OS 9: 64 MB or more (256 MB or more recommended)
• Mac OS X: 128 MB or more (512 MB or more recommended)

OS* Mac OS 9 (9.1 or later), Mac OS X (10.1.5 or later)

Interface Built-in USB 1.1 ports, USB 2.0.††

CPU Power PC G3 or later (G4 or later recommended)

USB** Only built-in Firewire ports supported.Firewire

http://www.ratocsystems.com/english/index.html
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Scanning BasicsScanning Basics
Scanning Images with Nikon ScanScanning Images with Nikon Scan

Required
Hardware

Nikon fi lm scanner

Film

Adapter and/or
fi lm holder

After installing Nikon 
Scan and Nikon 
View, connect the 
scanner and ready 
the fi lm and adapter 
or fi lm holder.  See 
the scanner User’s 
Manual for more in-
formation.

Nikon Scan

 1 Open the scan window

To use Nikon Scan as a “stand-alone” 
application, select Nikon Scan from 
the Start menu (Windows) or dou-
ble-click the Nikon Scan icon.

To use Nikon Scan to scan images 
into third-party applications such as 
Adobe Photoshop, select Nikon Scan 
from the application’s list of acquire 
or import sources.

 6 Save

Save the pictures using the Save or 
Save As… command in the host ap-
plication.

 5 Scan
Scan

Click the Scan button to scan the 
images.  The images will be opened 
in windows in the host application.

 4 Adjust settings

Use the tools in the scan window 
and Tool Chest to adjust settings and 
enhance pictures before scanning.

Tool Chest

Scan window

 3 Preview
Preview

Click the Preview button to preview 
images in the scan window.

Nikon View

Use Nikon View to organize saved 
pictures.

 2 Insert fi lm
See the scanner User’s Manual for 
details.
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Getting StartedGetting Started
Before ScanningBefore Scanning

Supported Scanners and Film
Nikon Scan 4 supports the following scanners:
• SUPER COOLSCAN 9000 ED (9000 ED)
• SUPER COOLSCAN 5000 ED (5000 ED)
• COOLSCAN V ED

• SUPER COOLSCAN 8000 ED (8000 ED)
• SUPER COOLSCAN 4000 ED (4000 ED)
• COOLSCAN IV ED

The following types of fi lm can be scanned:

Film holder/adapter

FH-835M

FH-835S

FH-869S

FH-869G

FH-896GR

FH-816

FH-8G1

FH-869M

MA-21/MA-20 (S)

SA-21

FH-G1

SF-210/SF-200 (S)

IA-20 (S)

SA-30

FH-3

Film

35-mm fi lm

35-mm slides

Medium-format (120/220, 2¼ or Brownie) fi lm, electron microscope fi lm 

16-mm fi lm

Medium-format (120/220, 2¼ or Brownie) fi lm, electron microscope fi lm, 35-mm panorama fi lm 

Glass microscope slides

35-mm slides (batch scans and thumbnail preview not supported)

Medium-format (120/220, 2¼ or Brownie) slides

35-mm fi lm (in strips of 2–6 frames)

Glass microscope slides (batch scans and thumbnail preview not supported)

35-mm slides (up to 50 slides 1.5 mm thick; thumbnail preview not supported)

APS (IX-240) fi lm cartridges

35-mm fi lm (in strips of 2–40 frames)

35-mm fi lm (in strips of 1–6 frames; batch scans and thumbnail preview not supported)

Scanner

9000 ED
8000 ED

5000 ED
4000 ED

COOLSCAN V ED
COOLSCAN IV ED

5000 ED
4000 ED
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Starting Nikon Scan
Before scanning, complete the following steps (see the scanner documentation for details):
• Install Nikon Scan
• Connect the power and interface cables
• Turn the scanner on and insert the adapter, and/or place fi lm in the fi lm holder

Nikon Scan can be used as a “stand-alone” application to scan, process, print, and save images, or it can be used to scan 
images into a third-party application such as Adobe Photoshop, where the images can then be processed, printed, or saved.  
The application in which images are displayed after scanning is known as the “host application.”

  Starting Nikon Scan as a “Stand-Alone” Application (Windows)Starting Nikon Scan as a “Stand-Alone” Application (Windows)
If a shortcut was created during installation, Nikon Scan can be started by double-clicking the Nikon Scan icon on the desktop.

  Starting Nikon Scan as a “Stand-Alone” Application (Macintosh)Starting Nikon Scan as a “Stand-Alone” Application (Macintosh)
If Nikon Scan was added to the Dock or an alias was created during installation, Nikon Scan can be started by clicking the Nikon Scan icon in the 
Dock (Mac OS X) or by double-clicking the alias on the desktop (Mac OS 9).

  Calibration (9000 ED, 8000 ED)Calibration (9000 ED, 8000 ED)
When the 9000 ED is turned on, the status LED will blink for one to two minutes while the scanner is calibrated.  Do not start Nikon Scan until the 
status LED has stopped blinking.  In the case of the 8000 ED, calibration is not performed until Nikon Scan is started.  Do not use the controls in 
the scan window or Tool Chest until the status LED has stopped blinking.  

Operation Nikon Scan used as “stand-alone” application Third-party host application

Scanning

Images are previewed in the Nikon Scan scan window and modifi ed using the tools in the Tool Chest.  Scan settings are adjusted 
in the scan window and “Preferences” dialog.  When preview is complete, click the Scan button to scan the images into image 
windows in the host application.

Opening the 
scan window

Open the Start menu and select Nikon Scan 4 from the pro-
gram list (Windows only) or double-click the Nikon Scan icon 
in the install destination folder.

Select Nikon Scan from the application’s list of “Acquire” or 
“Import” sources.  For more information, see the documenta-
tion provided with the application.

Processing Images are processed in Nikon Scan. Images are processed in the third-party application.

Images are saved from Nikon Scan. Images are saved from the third-party application.Saving images
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Starting Nikon Scan as a “Stand-Alone” Application
The scan window opens on the desktop and menus for the 
Nikon Scan application appear in the Nikon Scan application 
window (Windows) or menu bar (Macintosh).  The Tool Chest 
will also be displayed the fi rst time Nikon Scan is used.

Starting Nikon Scan from a Third-Party Application
Selecting Nikon Scan from the application’s list of acquire or 
import sources opens the scan window.  If this is the fi rst time 
Nikon Scan is used, the Tool Chest will also be displayed.

Tool Chest

Scan window

Nikon Scan application window (Windows only)

Tool Chest

Scan window

Third-party application (illustration shows Adobe 
Photoshop)
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Opening the Scan Window from Nikon Scan
When Nikon Scan is used as a “stand-alone” application, the 
scan window can be opened by selecting the scan window 
from the Nikon Scan Tools menu.  Use this option if the scan 
window has been closed after scanning.

Windows
• Select the scan window from the Tools menu.

• Select Open Twain Source from the File menu.
• Click the  icon in the toolbar.

Macintosh
• Select the scan window from the Tools menu.
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Elements of Nikon ScanElements of Nikon Scan
Getting to Know Nikon ScanGetting to Know Nikon Scan

The Nikon Scan interface includes the windows identifi ed below.  Click the links for more information.

Tool Chest (  30)
The Tool Chest contains 
tools for scanning and 
enhancing images.

Image windows (  106)
Images are opened in im-
age windows after scan-
ning, where they can be 
enhanced, printed, and 
saved.

Scan window (  12)
This is where images are pre-
viewed and modifi ed before 
scanning.

Preferences (  77)
The “Preferences” dialog con-
trols scan window settings.

Progress window (  22)
Shows the status of current tasks and lists operations that have been or are 
about to be performed.



12The Scan Window

The Scan Window
The Scanner-Computer Interface

The parts of the scan window are identifi ed below.  Click the links for more information.

Thumbnail drawer tab (  23)
Click to display the thumbnail area, where multiple 
frames can be selected for preview or scanning.

Title bar
Shows the scanner currently 
connected.

Preview area (  27)
Preview images before scan-
ning.

Interactive help
(Windows only)

Displays a brief tip about the 
control under the cursor.

Interactive help text and tool 
tip for the Preview button

Control area (  13)
Contains frequently used scan-
ning and preview controls.

Information panel (  25)
Lists information on current 
settings.

Preview button (  26)
Click to view selected frames 
in the preview area.

Scan button (  28)
Click to scan the selected frames.
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The Control AreaThe Control Area
Scan Window ControlsScan Window Controls

The scan window control area contains frequently-used preview and scan controls.  Click the links below for more informa-
tion about the buttons and menus in the control area.

Name Control Description

Tools button (  22) Display the Tool Chest or progress window.

Preferences button (  21) Open the “Preferences” dialog.

Frame size menu (  20)
(9000 ED/8000 ED only)

Specify the fi lm frame size.

Color model menu (  20) Choose to scan images in color or grayscale.

Film type menu (  19) Specify the type of fi lm to be scanned.

Zoom buttons (  16)
Zoom the crop selected in the preview area in or 
out.

Autoexposure button (  16) Optimize exposure automatically.

Settings menu (  17) Save, reset, and load scan window settings.

Eject button (  14) Eject the fi lm or holder.

Help button (  21) View help.

Autofocus button (  15)
Focus the scanner on the point selected with the 
focus tool.
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The Eject Button
The  (eject) button ejects fi lm 
holders or ejects or rewinds fi lm 
as described below.

Adapter Description

SA-30 (available separately for 
5000 ED and 4000 ED) Ejects fi lm from adapter.

SA-21 Ejects fi lm from adapter.

IA-20 (S) (available separately) Rewinds fi lm.

SF-210/SF-200 (S)
(available separately for 5000 ED 

and 4000 ED)

Ejects current slide and feeds a 
new one.  To eject current slide 
without feeding a new slide, press 
Ctrl (Windows) or option (Macin-
tosh) while clicking eject button.

MA-21/MA-20 (S) Eject button not available.
9000 ED/8000 ED
Clicking the  button ejects fi lm holders from the scanner.

5000 ED/4000 ED/COOLSCAN V ED/COOLSCAN IV ED
The operation performed by the  button varies depending 
on the adapter used.

  MA-21/MA-20 (S)MA-21/MA-20 (S)
When the MA-21/MA-20 (S) is inserted in the scanner, the  button is 
grayed out and unavailable.  Use the eject button on the adapter.
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The Autofocus Button
Clicking the  (autofocus) button 
focuses the scanner on a selected 
point (if no focus point has been 
selected, the scanner will focus 
on the center of the frame).

  Autofocus PreferencesAutofocus Preferences
Depending on the options selected in the “Preferences” dialog, an auto-
focus operation may be performed automatically when the focus point 
is moved or an image is previewed or scanned:
• If Perform autofocus when focus point is moved is selected in the 

“Automatic Actions” category of the “Preferences” dialog, the scan-
ner will automatically refocus when a new focus point is selected using 
the Focus Tool.

• If Auto focus is selected for “Before scan” in the “Single Scan” 
category of the “Preferences” dialog, an autofocus operation will au-
tomatically be performed when the Scan button is clicked to scan a 
single image.

• If a batch scan is performed when Auto focus is selected for “Before 
each image” in the “Batch Scan” category of the “Preferences” dialog, 
the scanner will automatically perform an autofocus operation before 
each scanning each image.

• If Auto focus is selected for “Settings to be applied to preview” 
in the “Preview Settings” category of the “Preferences” dialog, an 
autofocus operation will automatically be performed when a frame is 
previewed.

To select a new focus point, click the  button while press-
ing the Ctrl (Windows) or option (Macintosh) key.  The cur-
sor will take the shape of a set of cross hairs ( ).  Move the 
cursor over the point in the preview image that will be used 
as the new focus point and click to focus the scanner on the 
selected point.

  The Focus ToolThe Focus Tool
The focus point can be moved using the Focus Tool in the “Layout Tools” 
palette.  Click the  button in the “Layout Tools” palette to select the 
Focus Tool, then click in the preview image to select a focus point.
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The Autoexposure Button
At default settings, the scanner 
automatically adjusts exposure 
as necessary before displaying 
images in the preview area.  The 

 (autoexposure) button is only 
required if autoexposure has been 
turned off by removing the check from the Auto exposure 
for positive fi lm or Auto exposure for negative fi lm 
options in the “Single Scan,” “Batch Scan,” or “Preview Set-
tings” categories of the “Preferences” dialog.  In these cases, 
click the  button before performing the selected operation 
(single scan, batch scan, or preview) on fi lm of the affected 
type (positive or negative).

The Zoom Buttons
Click the  button to zoom in on 
the current crop, enlarging it to fi ll 
the preview area.  If a smaller se-
lection is made within the original 
crop, clicking the  button will 
zoom the new selection in to fi ll 
the preview area.  To zoom out 
to the previous view, click the  
button.

  Preview Image QualityPreview Image Quality
The image in the preview area may seem rough and uneven at high 
zoom ratios.  This can be cured by clicking the Preview button to pre-
view the image at the new zoom ratio.
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The Settings Menu
The settings menu can be used to 
save and export the following set-
tings and recall them as desired:
• the current scanner, fi lm type, 

color model, and the location 
and dimensions of the current 
crop

• all settings in effect in the Tool 
Chest, including image orienta-
tion, curves, color balance, LCH 
Editor, Unsharp Mask, and Digi-
tal ICE4 Advanced settings

  Tool Palette Settings MenusTool Palette Settings Menus
The settings for the “Crop,” “Curves,” “Color Balance,” “LCH Editor,” 
“Unsharp Mask,” and “Digital ICE4 Advanced” palettes can be saved 
and recalled separately using the palette settings menu.

  “Save Settings…” / “Export Settings…”“Save Settings…” / “Export Settings…”
To save settings for the current image, use the Save Settings… or Ex-
port Settings… options before previewing another image.
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The settings menu contains the following options:

Option Description

Import 
Settings…

Imports settings created with the Export Settings… 
option.

Delete 
Settings…

Displays dialog where settings created with Save Set-
tings… can be selected for deletion.

Export
Settings…

Exports current settings to a user-specifi ed location.  
Settings fi les have the extension “.set”.

Set User 
Settings

Saves current settings as user default settings, which can 
be recalled by selecting “reset to user settings” options 
in the scan window or tool palette settings menus.  Set-
tings created with the SA-21, IA-20 (S), or SA-30 can be 
used with any of these adapters, while settings created 
with the 9000 ED/8000 ED apply to all fi lm holders.

Save
Settings…

Saves current settings under a user-specifi ed name.  
Saved settings will be added to the end of the settings 
menu.

Clear User 
Settings

Deletes user defaults created with the Set User Set-
tings option.

Restore 
Factory 
Defaults

Restores the settings in effect at installation.

Reset User 
Settings

Restores user default settings created with Set User 
Settings.  Settings created with the SA-21, IA-20 (S), 
or SA-30 can be used with any of these adapters, while 
settings created with the 9000 ED/8000 ED apply to all 
fi lm holders.

Option Description

Last Saved 
Settings

Restores the most recent settings created with Save 
Settings…, Set User Settings, or Export Settings….

Saved
settings list

To apply saved settings to selected thumbnails or to the 
image in the preview window, select the desired settings 
from the list at the end of the settings menu.

  Settings for Other Adapters or ScannersSettings for Other Adapters or Scanners
The maximum crop size and other settings differ depending on the 
adapter and scanner used. When settings for a different scanner or 
adapter are selected from the settings menu, only those options that 
apply to the current adapter are affected.
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The Film Type Menu
Choose the type of fi lm to be scanned 
from the options in the fi lm type 
menu.

Option Description

Kodachrome

Use with Kodachrome positives.  Kodachrome fi lm is 
manufactured by Eastman Kodak and is usually mount-
ed in cardboard or plastic slide mounts embossed or 
printed with the label “Kodachrome.”

Neg (Mono) Use with black-and-white negatives.

Neg (Color)

Use with color fi lm negatives.  Color negatives can be 
identifi ed by their orange-tinted fi lm base and by the 
fact that the colors in the images are reversed.

Positive

Use with most makes of positive slides and reversal 
fi lm.  These fi lms have a black fi lm base, and the image 
in each frame appears in its actual colors.

  9000 ED/8000 ED9000 ED/8000 ED
The fi lm type menu is only available when a fi lm holder is inserted in 
the scanner.

  Glass Microscope SlidesGlass Microscope Slides
Select Positive when scanning glass microscope slides with the optional 
FH-G1 or FH-8G1 fi lm holder.
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The Frame Size Menu (9000 ED/8000 ED Only)
When scanning medium-format (120/
220, 2¼ or Brownie) fi lm using the FH-
869S or optional FH-869G fi lm holder, 
select the frame size from the options 
below (with other holders, the appro-
priate frame size is selected automati-
cally).  The maximum length of the fi lm 
strip that can be scanned in these hold-
ers depends on the frame size.

Frame size Maximum length

6 × 9 (cm)

Two frames

6 × 7 (cm)

6 × 6 (cm) Three frames

6 × 4.5 (cm) Four frames

6 × 8 (cm)

The Color Model Menu
Choose whether to scan images in 
color or monochrome (grayscale).  
The options available depend on 
whether the Nikon Color Manage-
ment System (CMS) in on (the default 
setting) or off.

Option Description

RGB
(CMS off) Use to edit raw RGB data from the scanner.

Calibrated RGB
(CMS on)

Choose when scanning images that will be printed in 
color or edited or displayed on a computer monitor.

Grayscale
Choose when scanning images that will be printed 
or displayed in monochrome.

  Nikon Color ManagementNikon Color Management
Color management systems using ICC profi les ensure consistent color 
reproduction among devices such as scanners, monitors, and printers.  
The Nikon Color Management System is one such ICC profi le system, 
and functions to ensure that colors from the scanner are reproduced 
accurately on the monitor.  See the “Nikon Color Management System” 
(  78) for details.

  Calibrated RGB/RGBCalibrated RGB/RGB
Calibrated RGB is available when Use Nikon Color Management 
is selected in the “Color Management” category of the “Preferences” 
dialog, RGB when it is not.

The color-model
menu (CMS on)
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Clicking the Help button displays 
the Nikon Scan help dialog.

The Help Button

“Nikon Scan Help” dialog

Clicking the Prefs (preferences) 
button displays the “Preferences” 
dialog (  77).

The Preferences Button

  Using Nikon Scan as a Stand-Alone ApplicationUsing Nikon Scan as a Stand-Alone Application
The “Preferences” dialog can also be opened by selecting Prefer-
ences… from the Edit menu (Windows, Mac OS 9) or the Nikon Scan 
application menu (Mac OS X).

“Preferences” dialog
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Clicking the Tools button displays a menu that can be used 
to open the Tool Chest or progress window.

The Tools Button

The Tool Chest
Select Tool Palette 1 to open the Tool Chest (  30).

The Progress Window
Selecting Progress Window 
opens the progress window.  The 
progress of the current task (ac-
quiring thumbnails, preview, or 
scanning) is shown at the top of 
the window.  To cancel the current 
task, click Stop.

Clicking the triangle under the 
progress meter displays the 
“Queue” and “Log” tabs.  The 
“Queue” tab lists the tasks that  
have yet to be performed.  To can-
cel a task, select it in the list and 
click the  button.  The “Log” 
tab lists the tasks that have been 
completed.
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  Film Holders and Adapters That Do Not Support Thumbnail PreviewsFilm Holders and Adapters That Do Not Support Thumbnail Previews
The following fi lm holders and adapters do not support thumbnail previews: MA-21 / MA-20 (S) (5000 ED, 4000 ED, COOLSCAN V ED, COOLSCAN 
IV ED), SF-210 / SF-200 (S) (available separately for the 5000 ED and 4000 ED), and FH-869GR (available separately for the 9000 ED and 8000 ED).  
The thumbnail drawer tab is not displayed when these adapters and holders are inserted in the scanner.

  Batch ScansBatch Scans
Batch scans are supported with the following fi lm holders and adapters:

The Thumbnail Drawer TabThe Thumbnail Drawer Tab
Selecting FramesSelecting Frames

If the current adapter or fi lm holder supports thumbnail pre-
views, the frames to be scanned can be selected from the 
thumbnail drawer.  Click the thumbnail drawer tab to open the 
thumbnail drawer.  By default, frames are listed by number; to 
display the frames as small “thumbnail” previews, click the  
button.  Frames can be selected for preview or scanning by 
clicking the associated frame number or thumbnail.  To select 
multiple frames for a “batch” scan, click each frame while press-
ing the Ctrl (Windows) or command (Macintosh) key, or press 
the shift key and click two images to select these images and all 
frames between them.

Thumbnail
drawer tab

Click to display thumbnails

Frame 
numbers

Thumbnail drawer

9000 ED/8000 ED

FH-8G1  (available separately)

FH-869M  (available separately) FH-816  (available separately)

FH-869S FH-869G (available separately)

FH-835M FH-835S

5000 ED/4000 ED/COOLSCAN V ED/COOLSCAN IV ED

SA-30 (available separately for 5000 ED and 4000 ED)

SF-210 / SF-200 (S)
(available separately for 5000 ED and 4000 ED)

SA-21 IA-20 (S)  (available separately)

Click to hide thumbnails
Click to close 

thumbnail 
drawer

Drag to resize 
thumbnail 

drawerSelected thumbnail
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  High-Contrast ImagesHigh-Contrast Images
Thumbnails may have unusual coloration if the associated image is very high contrast.  The preview image and fi nal scan are unaffected.

  Film OffsetFilm Offset
Thumbnails generated with the FH-869S, FH-869G, SA-21, or SA-30 may be slightly out of position.  Use the Strip Film Offset control in the 
“Scanner Extras” palette to adjust thumbnail position.

  Frame CountFrame Count
The frame number display for the SA-21 (supplied with the 5000 ED, 4000 ED, COOLSCAN V ED, and COOLSCAN IV ED) always contains six frames 
regardless of the actual number of frames in the fi lm strip, while the frame number display for the SA-30 (available separately for the 5000 ED and 
4000 ED) always contains forty frames.  The correct number of frames will be displayed when the  button is clicked to create thumbnail pre-
views.  Both the frame number and thumbnail displays for the 9000 ED and 8000 ED contain as many frames as there are apertures in the holder, 
even if some apertures are empty.

  The Thumbnail DisplayThe Thumbnail Display
The thumbnail display is stored in memory until new fi lm is inserted in the scanner.
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The Information PanelThe Information Panel
Image InformationImage Information

The information panel provides information about the image in the preview area.

Area Description See also

Shows the orientation of the preview image, refl ect-
ing any fl ips or rotations that have been performed.  
If the image has been fl ipped, the letter “R” will be 
shown in red.

Orientation

• Layout Tools (  33)

Gives the height and width of the current crop in pix-
els, and the size of the fi le that will result if the crop is 
scanned at the current output size and resolution.

• Crop (  36)

Dimensions/File size

Shows the status of analog gain, Digital ICE4 Ad-
vanced, and the Scan Image Enhancer.  A warning 
icon will be displayed if the preview image has not 
been updated to refl ect changes to these settings. 

Image enhancement

• Analog Gain (  69)
• Digital ICE4  Advanced (  61)
• Scan Image Enhancer (  70)

Indicates the current bit depth (which determines the 
number of colors in the image) and whether multi-
sample scanning (9000 ED, 8000 ED, 5000 ED, and 
4000 ED only) is in effect.

Scanner extras

• Scanner Extras (  71)

Lists the color values for the point under the cursor.  
If changes are made to the settings listed at right, the 
colors in the “Natural” tab will be listed in the top row, 
the colors in the “Processed” tab in the bottom row.

Color values

• Curves (  41)
• Color Balance (  51)
• LCH Editor (  56)
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The Preview ButtonThe Preview Button
Previewing ImagesPreviewing Images

Click the Preview button to view the image to be scanned in the preview area.  If multiple frames are selected in the thumb-
nail drawer, a preview will be performed for each frame.  Click the selected thumbnails in the thumbnail drawer to switch 
back and forth between previews.

Preview 
button

Preview area

  Updating PreviewsUpdating Previews
Be sure to click the Preview button to update the image after selecting a new frame size (9000 ED/8000 ED only) or fi lm type, or after making 
changes to Digital ICE settings in the “Digital ICE4 Advanced” palette or to the Strip Film Offset option in the “Scanner Extras” palette.
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The Preview AreaThe Preview Area
Previewing the Effects of Changes to SettingsPreviewing the Effects of Changes to Settings

The preview image created when the Preview button is clicked is displayed in the preview area.  The preview area contains 
two panels: a “Natural” panel showing the unprocessed image and a “Processed” panel that shows the effects of any 
changes to settings.  Click the “Natural” and “Processed” tabs for a quick “before-and-after” comparison that helps deter-
mine whether changes to settings are having the desired effect.

“Processed” (shows changes to settings) “Natural” (unprocessed image)

  Switching Between the “Natural” and “Processed” PanelsSwitching Between the “Natural” and “Processed” Panels
When Nikon Scan is used as a stand-alone application, the Show Natural Pane /Show Processed Pane options in the Scanner menu and the 
Ctrl-T (Windows)/command-T (Macintosh) shortcuts can be used to switch back and forth between the “Natural” and “Processed” tabs.

  “Analog Gain” / “Scan Image Enhancer”“Analog Gain” / “Scan Image Enhancer”
Changes to analog gain and the Scan Image Enhancer are refl ected in both the “Natural” and “Processed” panes.
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The Scan ButtonThe Scan Button
Scanning ImagesScanning Images

Click the Scan button to scan begin scanning (if multiple images are selected in the thumbnail drawer, all the selected im-
ages will be scanned).  When scanning is complete, the images will be opened in image windows in the host application.

Image 
window

  “Host Application”“Host Application”
The “host application” is the application in which images are displayed after scanning.  When Nikon Scan is used as a “stand-alone” application, 
scanned images will be opened in Nikon Scan.  If Nikon Scan is used as a TWAIN source or acquire plug-in for a third-party application such as 
Adobe Photoshop, images will be opened in image windows in the third-party application.

Scan button
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Batch Scans
“Batch” scans allow a “batch” of multiple frames to be 
scanned with a single click of the Scan button.

Using the Thumbnail Drawer
Batch scans can be performed with fi lm holders and adapters 
that support thumbnail previews (  23): all frames selected 
in the thumbnail drawer are scanned when the Scan button 
is clicked.  The images can be scanned at the same settings, 
or settings can be adjusted separately for each frame.

Multiple Frames, Same Settings
1. Select one frame in the thumbnail drawer.
2. Preview the image and adjust settings as desired.
3. Save changes to settings in the scan window settings 

menu (  17).
4. Select all the frames to be scanned in the thumbnail drawer.
5. Select the saved settings from the settings menu (if this 

step is omitted, the settings in the scan window and Tool 
Chest will apply only to the fi rst frame; the remaining 
frames will be scanned at default settings).

6. Click the Scan button to scan the selected frames.

Multiple Frames, Different Settings
1. Select the frames to be scanned in the thumbnail drawer.
2. Preview the frames and adjust settings separately for each im-

age (use the thumbnail drawer to switch between frames).
3. Click the Scan button to scan the selected frames.

SF-210/SF-200 (S) Slide-Feeder Adapters
The slide feeder adapters available separately for the 5000 
ED and 4000 ED also support batch scans, allowing a series 
of slides to be scanned automatically at the same settings.

1. Preview the fi rst slide and adjust settings as desired.
2. Select the number slides to be scanned in the “Scanner 

Extras” palette (  76).
3. Click the Scan button to scan the slides at current set-

tings.

  Batch Scan SettingsBatch Scan Settings
Settings in the scan window and Tool Chest will be reset to default val-
ues if the fi lm or holder is ejected before the Scan button is clicked.

Slide Feeder AdaptersSlide Feeder Adapters
Because slide feeder adapters do not support thumbnail previews, im-
ages can not be selected in the thumbnail drawer, nor can settings be 
adjusted separately for each slide in a batch scan.  To scan a series of 
slides at different settings, preview and scan each slide separately.

  “Preferences” > “Batch Scan”“Preferences” > “Batch Scan”
The “Batch Scan” category (  96) in the “Preferences” dialog contains 
a variety of batch scan options.
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Using the Tool Chest (  31)

Curves (  41)

Information (  35)

Layout Tools (  33)

Crop (  36)

Color Balance (  51)

Unsharp Mask (  53)

LCH Editor (  56)

Digital ICE4  Advanced (  61)

Analog Gain (  69)

Scan Image Enhancer (  70)

Scanner Extras (  71)

  The Scan Window and Image WindowsThe Scan Window and Image Windows
The “Crop,” “Digital ICE4 Advanced,” “Analog Gain,” “Scan Image Enhancer,” and “Scanner Extras” palettes are available only in the scan win-
dow.  When Nikon Scan is used as a “stand-alone” application, the other palettes can be used both before scanning (in the scan window) and 
after scanning (in image windows).

The Tool Chest
Setting up Scans and Enhancing Images

The tools in the Tool Chest can be used before scanning to select the area to be scanned, rotate and fl ip images, specify 
size and resolution, adjust color, brightness, and contrast, improve sharpness, and mitigate the effects of dust, scratches, 
and fading.  When Nikon Scan is used as a “stand-alone” application, some tools can also be used to edit images opened 
in image windows after scanning.  Click the links below for more information.
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Using the Tool ChestUsing the Tool Chest
Tool Chest OperationsTool Chest Operations

Opening the Tool Chest
To display the default Tool Chest, click the Tools button in the 
scan window control area and select Tool Palette 1 from 
the menu that appears.

Displaying the Contents of a Tool Palette
To display or hide the contents of a tool palette, click the 
triangle to the left of the palette title.

Title bar



32TOPThe Tool Chest — Using the Tool Chest

Opening a Tool Palette in a Separate Window
Tool palettes can be opened in a separate window by click-
ing the palette title and dragging it outside the current win-
dow to create a new Tool Chest con tain ing only the selected 
palette.

Tools can be added to the new window by drag ging ad-
 di tion al palettes into the window.  The new window will be 
added to the tools menu in the scan window.  If you close 
the new window by click ing the win dow close box, you can 
open it again by se lect ing the desired Tool Chest from the 
tools menu.

Changing the Order of Palettes in the Tool Chest
To change the order of palettes in the Tool Chest, click a tool 
palette title bar and drag it into a new position.

Moving the “Layout 
Tools” palette to a 
position following 
the “Crop” palette
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Layout ToolsLayout Tools
Setting up Scans and Orienting ImagesSetting up Scans and Orienting Images

The “Layout Tools” palette contains tools for making selec-
tions and adjusting focus in the scan window.  It can also be 
used to fl ip and rotate images both before and after scan-
ning and to navigate images displayed in image windows.

The tools available in the “Layout Tools” palette differ de-
pending on whether the active window is the scan window 
or an image window.

Tool Image windowScan window

Flip ✔ ✔

Rotate ✔ ✔

Hand Cursor — ✔

✔ ✔Crop Cursor

— ✔Zoom Cursor

✔ —Focus Tool

 The Hand Cursor (Image Windows Only)
When Nikon Scan is used as a “stand-alone” application, the 
Hand Cursor tool can be used to scroll images that have been 
opened in image windows after scanning.  It can not be used 
in the scan window or a third-party host application.

 The Crop Cursor
The Crop Cursor tool is used to make a selection, or “crop.”  
In the scan window, the crop is the area selected for scan-
ning.  In image windows, the crop is the source of the his-
togram.

To make a selection, drag the mouse 
over the image in the active window.  
The size of the crop can be changed 
by dragging its borders, its location by 
placing the cursor anywhere inside the 
crop and dragging it to a new posi-
tion.  To cancel the crop, double click 
anywhere outside the selected area.
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 The Zoom Cursor (Image Windows Only)
When Nikon Scan is used as a “stand-alone” application, 
the Zoom Cursor tool is used to zoom the images in the ac-
tive image window in or out.  It can not be used in the scan 
window or a third-party host application.

Select the Zoom Cursor tool and click anywhere within the 
image window to zoom in on the selected point.  To zoom 
out, click the image while pressing Alt (Windows) or option 
(Macintosh).

The Zoom Cursor tool can also be activated by selecting 
Zoom Cursor from the Nikon Scan View menu.

 The Focus Tool (Scan Window Only)
The Focus Tool is used to select the focus point in the scan 
window.  It is only available when the scan window is active.  
See “The Autofocus Button” (  15) for more information.

/  Rotate Buttons
Clicking these buttons rotates the image in the active win-
dow.  Any rotations are refl ected in the orientation of the 
letter “R” in the “Layout Tools” palette.

/  Flip Buttons
Clicking these buttons fl ips the image in the active window.  
The letter “R” in the “Layout Tools” palette turns red when 
the image is fl ipped.

Button Description

Flips image vertically. ABC
ABC

Flips image horizontally. ABC ABC

Button Description

Rotates image 90 ° clock-
wise.

ABC

A
B

C

Rotates image 90 ° coun-
terclockwise.

ABC

A
B

C

Button Description

Show Grid
When this option is checked, a layout grid is displayed in the 
active window.  The “Grid Settings” category in the “Prefer-
ences” dialog (  105) controls grid spacing and color.
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InformationInformation
Pixel and Crop InformationPixel and Crop Information

The “Information” palette provides information about the 
size and location of the current crop, the position of the cur-
sor within the active image, and the color of the point under 
the cursor.

  The “Information” PaletteThe “Information” Palette
The “Information” palette is automatically updated to refl ect changes to 
the crop in the “Crop” palette.  All measurements are in pixels.

The “Information” palette can be used in both the scan window and in 
image windows.

Item Description

W:
H: Height and Width of crop.

L:
T: Coordinates of Top Left corner of crop.

X:
Y:

Horizontal (X) and vertical (Y) distance of cursor from top left 
corner of image.

Color values for point under cursor.  If selected color model 
is grayscale, only one channel (Luminosity, or brightness) is 
shown.  If selected color is model RGB, separate values are 
shown for Red, Green, and Blue channels.  If image has been 
modifi ed, two values will be shown for each channel, giving 
color before and after processing.  Size of area sampled to de-
termine color value can be changed using Sample point size 
option in “Advanced Color” category of the “Preferences” 
dialog (  102).

L: R:
G:
B:

Calibrated RGB/RGB Grayscale
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CropCrop
Output Size and ResolutionOutput Size and Resolution

The “Crop” palette is used to specify the dimensions and 
resolution at which the current crop will be scanned.

Crop
(input) size 
(size of area 

scanned)

Output 
size

File size

ScaleOutput
resolution

Custom…
button

Three options are available for choosing output size and 
resolution.  Select an option according to how the image will 
be used.

Keep this Crop (  38)
Adjust output dimensions, fi le size, and resolution without 
changing the crop selected in the preview area.

Keep this Output Size (  38)
Adjust fi le size, resolution, and the selection in the preview 
area without changing the chosen output size.

Keep this File Size (  39)
Adjust output size, resolution, and the selection in the pre-
view area without affecting the chosen fi le size.

  The “Crop” PaletteThe “Crop” Palette
The “Crop” palette is only available when the scan window is active.
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The “Crop” palette contains the following items:

Item Description

Crop
(input)

size

Gives the dimensions of the current crop.  The units for 
input size can be chosen from the menu to the right of 
the display; the units chosen are refl ected in the rulers in 
the preview area.

Output 
size

Gives the output dimensions of the current crop (i.e., the 
size of the crop after scanning).  The units for output size 
can be chosen from the menu to the right of the display.  
If a new value is entered for Width or Height when Keep 
this crop is selected, the other value will change auto-
matically to maintain the current crop.  If Keep this fi le 
size is selected when Pixels is chosen in the output units 
menu, the other value will automatically change to main-
tain the specifi ed fi le size.  This change will be refl ected in 
the dimensions of the current crop.

File size

States the size of the fi le that will result if the crop is 
scanned at current settings, before JPEG compression (if 
applicable) and not including fi le headers (which typically 
increase fi le size by about 10 KB).

Scale
Scale (output size relative to the size of the image on fi lm) 
can be set by direct entry or using the Scale slider.

Output 
resolution

Enter a value for output resolution (minimum 90 ppi).  
The units for resolution can be chosen from the menu to 
the right of the text box.

Item Description

Custom…

Select from the following menu of custom resolutions:
Add Resolution .................. Add custom resolution
Delete Resolution .............. Delete custom resolution
Inkjet Printer ...................... Set resolution to 360 dpi
Dye Sublimation Printer .... Set resolution to 300 dpi
400 dpi Printer .................... Set resolution to 400 dpi

  Choosing an Output ResolutionChoosing an Output Resolution
• Inkjet printers

Most inkjet printers require three or four dots of different colors to 
reproduce a single pixel (simulated halftone).  The target output reso-
lution for an inkjet printer (in pixels per inch, or ppi) is therefore less 
than the printer’s catalogue resolution (in dots in per inch, or dpi).  In 
general, a resolution of 360 ppi will produce acceptable results.

• Dye sublimation printers
Printers that use photographic or dye-sublimation processes reproduce 
each pixel with a single dot (continuous halftone).  The target output 
resolution for these devices is therefore the same as the printer resolu-
tion.

• Commercial printing
Commercial printing processes typically use from 150 to 300 lines per 
inch (lpi).  As a rule of thumb, assume an output resolution (in ppi) of 
about double the number of lines per inch when scanning for output 
on a commercial printer.

• Monitors
Computer monitors are usually considered to have resolutions of from 
72 ppi (Macintosh) to 96 ppi (Windows).
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Follow the instructions below to choose an output size and 
resolution.

Keep this Crop
When Keep this Crop is selected, the size and location of 
the crop will not change when new values are entered for 
output size and resolution.  This option is the best choice for 
general-purpose scanning.
1. Select Keep this Crop.
2. Drag the mouse in the preview area of the scan window to 

select a crop.  If no crop is selected, the entire image will 
be scanned.

3. Choose an option from the output units menu and enter 
the desired value for Width or Height.  The remaining di-
mension will change automatically to maintain the current 
crop.  The output size can also be chosen using the Scale 
slider.

4. Choose an option from the resolution units menu and en-
ter the desired value for resolution, or select a resolution 
for a specifi c output device from the Custom… button 
menu.

Keep this Output Size
When Keep this Output Size is selected, the values en-
tered for output Width and Height will not change when the 
crop is resized or a new value is entered for fi le size.  Choose 
this option when scanning images that must display or print 
at a specifi ed size.
1. Select Keep this Output Size.
2. Choose an option other than pixels from the output units 

menu and enter the desired value for Width and Height.
3. Choose an option from the resolution units menu and en-

ter the desired value for resolution, or select a resolution 
for a specifi c output device from the Custom… button 
menu.

4. Adjust the size and location of the crop.  The crop will be 
maintained at the height-width ratio specifi ed in Step 2, 
and the value for scale will automatically be adjusted ac-
cording to the size of the crop.

  “Keep This Output Size” “Keep This Output Size” 
Keep this Output size fi xes the physical dimensions of the image when 
output on a printer on monitor.  When Pixels is selected in the output 
units menu, adjusting resolution will cause the values shown in the out-
put size text boxes to change.  The physical dimensions of the image 
when output on a printer on monitor will however remain constant.
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Keep this File Size
When Keep this File Size is selected, the fi le size will not 
change when the crop is resized or new values are entered 
for output size or resolution.  Choose this option to specify 
the exact fi le size of the fi nal image or to keep fi le sizes to a 
minimum for storage or electronic distribution.
1. Select Keep this File Size.
2. Choose an option from the fi le size units menu and enter 

the desired value for File size.
3. Drag the mouse in the preview area of the scan window to 

select the crop.  Output size, scale, and resolution will be 
adjusted automatically.

  File Size File Size 
The fi le size listed in the “Crop” palette does not refl ect fi le headers  
(which typically increase fi le size by about 10 KB) or JPEG compression.
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The Crop Settings Menu
Clicking the triangle in the top right corner of the “Crop” palette displays the crop settings menu.

Option Description

Reset to User Crop Settings

Reset to Default Crop Settings

Export Crop Settings…

Import Crop Settings…

Delete Crop Settings…

Save Crop Settings…

Copy Crop Settings to
Clipboard

(Macintosh only)

Copy current crop settings to the clipboard.  These settings can then be pasted into the “Crop” palette by 
selecting Paste from the Edit menu.

Save current crop settings under a user-specifi ed name.  These settings will be added to the end of the crop 
settings menu, where they can be recalled by selecting the desired settings by name.

Delete settings created using the Save Crop Settings… option.  A dialog will be displayed where the set-
tings to be deleted can be selected by name.

Import settings created using the Export Crop Settings… option.

Export current settings to a fi le in a location of your choice.  Crop settings fi les have the extension “.ncc”.

Cancel the current crop and reset resolution and scale to default values.

Restore the default crop settings created with the Set User Settings option in the scan window settings 
menu (  17).

MacintoshWindows
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  The Curve Edit DisplayThe Curve Edit Display
Although values for input and output in the “Curves” palette range from 
zero to 255 (eight-bit pre ci sion, familiar to users of other image editing 
software), the results of any changes to curves are calculated at a preci-
sion of sixteen bits.  This allows images scanned at twelve and fourteen 
bits to be modifi ed without lowering the quality of the output.

Input is plotted along the horizontal axis, with shadows (the 
dark areas of the image) to the left, high lights (the bright 
areas of the image) to the right, and mid-tones in between.  
The left end of the axis marks the minimum possible value 
for colors in the selected channel (zero, or no color), the right 
end the maximum value.  In the case of the master curve, the 
minimum value represents areas of the input image that are 
a true black; the maximum value represents areas that are a 
true white.  Output is plotted along the vertical axis, with the 
minimum possible output value (again, zero, or no color) at 
the bottom and the maximum output value at the top.

Current channel

Curve edit display

CurvesCurves
Fine-Tuning Color, Contrast, and BrightnessFine-Tuning Color, Contrast, and Brightness

The “Curves” palette is used to adjust brightness, contrast, 
and color in specifi c por tions of the tone range (highlights, 
mid-tones, and shadows).  The main editing tool in the 
“Curves” palette is the curve edit display, which contains a 
curve showing the relationship between input (the tones in 
the original image) and output (how the tones in the input 
will be represented in the fi nal image).  Separate curves 
control the re la tion ship between input and output for the 
image as a whole (the “master curve”) and for each of the 
com po nent colors, or “channels,” in the current color model 
(red, green, and blue in the case of the RGB color model).  
The default curve in each case is linear, meaning that tones 
will be output exactly as they are input.

  The “Curves” PaletteThe “Curves” Palette
The “Curves” palette can be used in both the scan window and in im-
age windows.
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When the cursor is moved over the curve edit display, the 
input and output values for the point under the cursor are 
shown in the input/output display.

  The “Apply” ButtonThe “Apply” Button
Changes to curves only apply when the button at the top left corner of 
the “Curves” palette is checked.  When this button is checked, changes 
to curves will be refl ected in the image in the active window.  The box 
can be checked and unchecked for a quick “before-and-after” compari-
son to determine whether changes to settings are having the desired 
effect.

Apply button

Input/output display

Step 1—Viewing the Histogram
The fi rst step in adjusting tone levels and 
color balance in the “Curves” palette is 
to view the histogram displayed in the 
background of the curve edit display.  The 
histogram provides information on what 
tones are present in the original image 
and in what amounts, information that 
is used when setting the black point and white point and 
editing curves.

The histogram takes the form of a bar graph.  The horizontal 
axis shows the tone level (pixel brightness), with shadows to 
the left and highlights to the right.  The vertical axis gives the 
number of pixels of each tone level found in the current crop, 
scaled to fi t in the curve edit display (note that the histogram 
does not show the position of pixels within the crop).

To view the distribution of tones in the fi nal, output image 
after changes to curves, click the  button.  Click the but-
ton again to view the input tone distribution.

  Sixteen-Bit Images Sixteen-Bit Images 
The histogram uses eight-bit precision, with the result that spikes may 
be visible in the histogram when previewing images at a bit-depth of 
sixteen bits. Sixteen-bit precision is however used when the image is 
scanned.
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  Channel Selection ShortcutsChannel Selection Shortcuts
The current channel can also be selected using the following shortcuts:
• Ctrl ~ (Windows)/  ~ (Macintosh)

Master channel (RGB)
• Ctrl 1 (Windows)/  1 (Macintosh)

Red channel (RGB)
• Ctrl 2 (Windows)/  2 (Macintosh)

Green channel (RGB)
• Ctrl 3 (Windows)/  3 (Macintosh)

Blue channel (RGB)

Step 2—Channel Selection
The channel menu is used to select compo-
nents of the current color model for editing.  
Select the master curve to modify tones for 
all channels in the image.  In the RGB color 
model, the red, green, and blue curves can 
be modifi ed separately.  The histogram shows tone levels for 
the selected chan nel only.

When the master curve is selected, the auto-contrast but-
 ton and white-point and black-point eye drop per tools apply 
simultaneously to all of the red, green, and blue curves (the 
master curve is un af fect ed).  When one of the red, green, 
and blue curves is selected, these controls can be used to 
edit only the se lect ed curve.

Step 3—Setting White and Black Points
The endpoints of the curve are referred to as the “white 
point” and the “black point.”  The black point for a given 
channel represents the darkest shade (minimum value) for 
that color, the white point, the brightest shade (maximum 
value).  By default, the input and output values for the black 
point are zero.  The darkest shade in the input image may 
however be greater than zero, with the result that a portion 
of the curve is dedicated to reproducing tones not actually 
present in the image.  Increasing the input value for the black 
point until it matches the darkest shade in the image will 
steepen the curve, en hanc ing overall contrast without caus-
ing a corresponding loss of detail in shadows.  Similarly, if the 
original image does not actually contain shades correspond-
ing to the maximum value, the white point can be lowered 
to match the brightest shade in the image.

There are two steps to selecting a white point and black 
point for the fi nal image: choosing the white-point and 
black-point input levels, and selecting out put levels.
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White-Point and Black-Point Input Levels
Input levels for the white point and black point can be set 
using any of the following three methods:
• automatic contrast adjustment
• white-point and black-point sliders
• direct sampling using the white-point and black-point 

eyedropper tools

Automatic Contrast Adjustment
In automatic contrast adjustment, Nikon Scan automati-
cally selects white and black points that exclude a certain 
percentage of the brightest and darkest pixels in the image, 
steepening curves for enhanced contrast (the exact percent-
age of pixels excluded can be specifi ed in the “Preferences” 
dialog). By default, 0.5% of the brightest and darkest pixels 
are excluded, producing a curve that makes optimal use of 
the output tone range while preserving details in shadows 
and highlights.

To perform an auto contrast operation, click the  but-
ton.  The white and black points for each of the red, green, 
and blue channels will be modifi ed simultaneously and the 
master curve will be displayed in the “Curves” palette (the 
master curve itself is unaffected by this operation).  Clicking 
the  button with the Ctrl (Win dows) or option (Macintosh) 
key held down adjusts contrast only for the channel cur rent ly 
se lect ed in the channel menu.

To modify brightness and contrast without affecting color 
balance, select the master channel and click the  button 
while pressing Ctrl (Win dows) or option (Macintosh).
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White-Point and Black-Point Sliders
The white-point and black-point sliders can be used to match 
the white and black points to the his to gram displayed in the 
curve edit display.  While these sliders can be used to edit 
curves for any channel, the best results are usually obtained 
when they are used to modify the master curve.

To edit the white point or black point, click the correspond-
ing slider once to activate it, then drag it to the right or left (a 
value can also be entered directly in the text box underneath 
the slider).  Matching the black-point slider with the low-
est input value displayed in the histogram will set the mini-
mum output value for the selected channel to the darkest 
pixel actually present in the image, steepening the curve and 
enhancing contrast without sacrifi cing detail in shad ows.  
Similarly, matching the white-point slider with the highest 
input value displayed in the histogram will set the maximum 
output value for the selected channel to the brightest pixel 
present in the image, enhancing contrast without loss of de-
tail in highlights.  Any changes are applied instantly to the 
active image.

Black-point 
slider

White-point 
slider

Black-point 
input value

White-point 
input value
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Sampling the Image for White Point or Black Point
The white point or black point can be set by directly sam-
pling the image, allowing the user to choose the pixels that 
will be used to set the maximum (white point) or minimum 
(black point) output value.  This makes it possible to set the 
black point by matching it to a pixel in the darkest part of 
the image containing detail you want to preserve, eliminat-
ing details in darker areas that are not important to the fi nal 
image.  Similarly, you can match the white point to a pixel in 
the brightest area of the image containing details important 
to the fi nal image.  While direct sampling can be used with 
any channel, it is most effective when used with the master 
curve.  When the master curve is selected, sampling will set 
the white or black point for red, green, and blue curves si-
multaneously; the master curve itself is unaffected.

  Setting the White or Black Point for the Current ChannelSetting the White or Black Point for the Current Channel
By default, sampling sets the white point or black point for all channels 
and displays the master curve.  To set the white point or black point for 
the current channel only, press the Ctrl key (Win dows) or option key 
(Macintosh) while clicking the  or  button.  To modify brightness 
and contrast without affecting color balance, select the master channel 
and press Ctrl (Win dows) or option (Macintosh) while clicking the  
or  button.

To sample the white point, click the  button.  When the 
cursor is moved over the active image, it will take the shape 
of an eyedropper.  Move the cursor over the image to fi nd 
the pixel that you want to use to set the white point, keeping 
an eye on pixel level display in the “Information” palette to 
identify pixels with high input values.  With the cursor over 
the target pixel, click the mouse button.  The input value 
for the selected pixel will be used as the input value for the 
white point.  The image will automatically be altered to re-
fl ect the new value for white point and the master curve will 
be displayed in the “Curves” palette.

To sample the image for the black point, click the  button 
and move the eye drop per cursor over the image until you 
fi nd the point that you want to use to set the min i mum input 
value, then click the mouse button to select the black point.
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White Point and Black Point Output Levels
Once the input levels for the black and white points have 
been determined, output levels can be altered to refl ect the 
actual shade of the darkest and brightest pixels in the image.  
If the darkest shade in the image represents a true black, 
for example, the output level for the black point can be left 
at zero.  If, however, darkest shade present in the image is 
a lighter color, the output level for the black point can be 
raised to achieve more natural coloration.

The output levels for the white point and black point are set 
using the white-point and black-point output sliders on the 
left side of the curve edit display.

To set the output level, click the slider once to activate it, 
then drag it up or down until you have found the desired 
output level (the output level can also be set by entering a 
value directly in the text box to the left of the slider).  The ef-
fects of the change will be refl ected in the active image.

Black-point 
output slider

White-point 
output slider

  Output LevelsOutput Levels
In some cases, it is best if the darkest and lightest points of the image 
are not printed or displayed as saturated black or white, even when the 
colors in the original represent a true black or true white.  For example:
• Making blacks less saturated can reduce the amount of ink consumed
• Making whites less saturated can prevent undesirable lines from ap-

pearing when a true white is printed in ink (for example, when white is 
printed on a colored background)

  Default Output ValuesDefault Output Values
The default output levels for white point and black point can be set in 
the “Advanced Color” category of the “Preferences” dialog (  101).
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  GammaGamma
Gamma (also written “γ”) is a fundamental property of video systems 
which determines the in ten si ty of the output signal relative to the input.  
When calculating gamma, the maximum possible input intensity is as-
signed a value of one, and the minimum possible intensity (no input) 
is assigned a value of zero.  Output is calculated by raising input to a 
power that is the inverse of the gamma value (output = input (1/γ) ).  In 
practical terms, raising the gamma value has the same effect as mov-
ing the midpoint slider to the left, raising mid-tone output values and 
brightening the image while leaving the maximum and minimum values 
untouched. Lowering the gamma value has the same effect as mov-
ing the midpoint slider to the right, lowering mid-tone output values 
and darkening the image.  The de fault value for gamma is one, which 
produces a linear curve in which input and output values are the same. 
Gamma can be set to any value between 0.45 and 3.00.

The Gray-Point Slider
The gray-point slider is located at the bottom of the curve 
edit display.

Step 4—Setting the Gray Point

Move the slider to the left to increase the brightness of 
mid-tones in the selected channel, or move it to the right 
to decrease brightness.  Al ter na tive ly, you can enter a value 
for gamma directly in the text box under the slider. The ef-
fects of changes to the gray point can be seen in the active 
image.

Gray-point 
slider

Gamma value

The point midway between the maximum and minimum 
input values is known as the “gray point” (or “midpoint”).  
This point represents a neutral shade corresponding to an 
output level of 128. The gray  point is controlled by a slider at 
the bottom of the curve edit display.  Moving the midpoint 
slider to the left increases the brightness of mid-tones with-
out “washing out” high lights.  Moving the slider to the right 
darkens mid-tones without obliterating detail in shad ows.

The midpoint can be set using the gray-point slider or by 
directly sampling the image using the gray-point eyedropper 
tool.
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Sampling the Image for Gray Point
The gray point can also be set by direct sampling.  Regardless 
of the channel currently selected in the channel menu, sam-
pling simultaneously defi nes the gray point for each of the 
red, green, and blue chan nels while leaving the gray point for 
the master curve unchanged.  Grayscale images can not be 
sampled for gray point.

To sample the gray point, click the  button.  When the cur-
sor is moved over the active image, it will take the shape of an 
eyedropper.  Move the cursor over the image to fi nd a pixel 
to use to set the gray point, keeping an eye on the pixel level 
display in the “Information” palette to identify pixels with a 
neutral input value (look for pixels that should be a neutral 
gray color in the fi nal image).  With the cursor over the target 
pixel, click the mouse button.  The gray point for each of the 
component channels will be adjusted to alter color balance 
without altering the brightness of the sampled pixel (the 
weight assigned to each channel can be selected using the 
“Gray point target” options in the “Advanced Color” catego-
ry of the “Preferences” dialog;  101).  The image will au-
 to mat i cal ly be altered to refl ect the new value for gray point.

Step 5—Editing Curves Directly
Curves can be reshaped to make adjustments to brightness 
and contrast in specifi c portions of the tone range.

Adding New Points to the Curve
Move the cursor to the desired location in the curve edit 
display and click.  A new point will be added at this position 
and the curve will automatically be adjusted to pass through 
this point.  Points can be repositioned by dragging them to 
new locations in the curve edit display.  Steepening a section 
of the curve will enhance contrast in that portion of the tone 
range, while changing the curve to map input to higher or 
lower output levels will brighten or darken tones in the af-
fected portion of the tone range.  The image in the active 
window will automatically be adjusted to refl ect changes to 
the curve.

Removing Points from the Curve
Points can be removed from the curve by dragging them out 
of the curve window.

Resetting the Curves to Linear
The default linear curve for the current channel can be re-
stored by clicking the  button in the “Curves” palette.  To 
reset all curves to linear, click the  button.  Resizing the Curve Edit DisplayResizing the Curve Edit Display

The Tool Chest can be resized by dragging its borders (Windows) or 
by dragging the handle at its lower right corner (Macintosh).  The size 
of the curves edit display changes with the size of the palette.  For in-
creased precision, enlarge the palette when editing curves.
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The Curves Settings Menu
Clicking the triangle in the top right corner of the “Curves” palette displays the curves settings menu.

Option Description

Reset to User Curve Settings
Restore the default curves settings created with the Set User Settings option in the scan window settings 
menu (  17).

Reset to Default Curve Settings Reset all curves to linear.

Export Curve Settings… Export current settings to a fi le in a location of your choice.  Curves settings fi les have the extension “.ncv”.

Import Curve Settings… Import settings created using the Export Curve Settings… option.

Delete Curve Settings…
Delete settings created using the Save Curve Settings… option.  A dialog will be displayed where the set-
tings to be deleted can be selected by name.

Save Curve Settings…
Save current curves settings under a user-specifi ed name.  These settings will be added to the end of the 
curves settings menu, where they can be recalled by selecting the desired settings by name.

Copy to Clipboard
Copy current curve settings to the clipboard.  These settings can then be pasted into the “Curves” palette 
for another window by activating the window and selecting Paste from the Edit menu.
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Color BalanceColor Balance
Adjusting Overall Color, Contrast, and BrightnessAdjusting Overall Color, Contrast, and Brightness

The “Color Balance” palette offers simple controls for adjust-
ing brightness, contrast, and color balance for the entire im-
age.  Unlike the controls in the Curves palette, however, the 
“Color Balance” palette does not allow changes that affect 
only a portion of the tone range.

The controls in the “Color Balance” palette are described op-
posite.  Note that when “grayscale” is selected for the color 
model, the “Color Balance” palette contains only brightness 
and contrast sliders.

  The “Color Balance” PaletteThe “Color Balance” Palette
The “Color Balance” palette can be used in both the scan window and 
in image windows.

  The “Apply” ButtonThe “Apply” Button
Changes to color balance only apply when the button at the top left 
corner of the “Color Balance” palette is checked.  When this button is 
checked, changes to color balance will be refl ected in the image in the 
active window.  The box can be checked and unchecked for a quick “be-
fore-and-after” comparison to determine whether changes to settings 
are having the desired effect.

Apply button

Sliders

Item Description

Brightness

The brightness slider adjusts brightness for the entire im-
age.  Dragging the brightness slider in the “+” direction 
brightens the image, while dragging the slider in the “–” 
direction darkens the image.  A value for brightness be-
tween –100 and +100 can be entered directly in the text 
box to the right of the slider.

Contrast

Dragging the contrast slider in the “+” direction height-
ens the difference between high lights and shadows in 
the image, increasing contrast.  Dragging the slider in the 
“–” di rec tion decreases the difference be tween light and 
dark portions of the image, lowering contrast.  A value 
for contrast between –100 and +100 can be entered in 
the text box to the right of the slider.

Color
balance 
(Red, 

Green, 
Blue)

While the brightness slider adjusts brightness for the im-
age as a whole, the three color-balance controls allow 
the user to adjust brightness for each color individually.  
For ex am ple, dragging the red slider in the “+” direction 
brightens the red portions of the image, making the im-
age as a whole more red.  Dragging it in the “–” direc-
tion dims the red elements in the image, bringing out 
the remaining colors.  Color balance can also be set by 
entering values between –100 and +100 directly in the 
text boxes to the right of the sliders.
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The Color Balance Settings Menu
Clicking the triangle in the top right corner of the “Color Balance” palette displays the color balance settings menu.

Option Description

Reset to User Color Balance Settings
Restore the default color balance settings created with the Set User Settings option in the scan 
window settings menu  (  17).

Reset to Default Color Balance Settings Reset all sliders to ±0.

Export Color Balance Settings…
Export current settings to a fi le in a location of your choice.  Color balance settings fi les have the 
extension “.nca”.

Import Color Balance Settings… Import settings created using the Export Color Balance Settings… option.

Delete Color Balance Settings…
Delete settings created using the Save Color Balance Settings… option.  A dialog will be dis-
played where the settings to be deleted can be selected by name.

Save Color Balance Settings…

Save current color balance settings under a user-specifi ed name.  These settings will be added to 
the end of the color balance settings menu, where they can be recalled by selecting the desired 
settings by name.

Copy to Clipboard

Copy current color balance settings to the clipboard.  These settings can then be pasted into the 
“Color Balance” palette for another window by activating the window and selecting Paste from 
the Edit menu.
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Unsharp MaskUnsharp Mask
Increasing SharpnessIncreasing Sharpness

Using Unsharp Mask, the user can increase the sharpness 
of images by making edges more dis tinct.  Unsharp Mask 
works by increasing the contrast of edges in the image while 
leaving other areas untouched. The amount of sharpness 
is determined by three factors: in ten si ty, halo width, and 
threshold.

  The “Unsharp Mask” PaletteThe “Unsharp Mask” Palette
The “Unsharp Mask” palette can be used in both the scan window and 
in image windows.

  The “Apply” ButtonThe “Apply” Button
Changes to Unsharp Mask only apply when the button at the top left 
corner of the “Unsharp Mask” palette is checked.  When this button is 
checked, changes to settings will be refl ected in the image in the active 
window.  The box can be checked and unchecked for a quick “before-
and-after” comparison to determine whether changes to settings are 
having the desired effect.

Apply button

Intensity
Halo width
Threshold

Unsharp Mask can be applied to all the colors in the image 
or selectively to areas of the image in which red, green, blue, 
cyan, magenta, or yellow predominate, as determined by the 
color values for each pixel.  The brightness (luminosity) of the 
affected pixels is adjusted to sharpen edges without affect-
ing color balance.  The controls in the Unsharp Mask palette 
can be used to create multiple masks, one for each color or 
for all colors.

  Unsharp MaskUnsharp Mask
Unsharp Mask sharpens edges without affecting color balance by ad-
justing only luminosity (brightness).  The effect is the same as perform-
ing Unsharp Mask with the Luminosity channel selected in the Adobe 
Photoshop Lab color model.

  Image Size and ResolutionImage Size and Resolution
The amount of Unsharp Mask required depends on the size and resolu-
tion of the fi nal image.  The more pixels in the image, the greater the 
amount of Unsharp Mask required to achieve the same degree of appar-
ent sharpness.  Before applying a mask, scale the image to the desired 
size and resolution.

  Nikon Color Management (Nikon Color Management (  78) 78)
Unsharp Mask is only available when the Nikon Color Management Sys-
tem (CMS) is on.  If Nikon CMS is off, the tools in the “Unsharp Mask” 
palette will be disabled.
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Creating Unsharp Masks

Step 1—Select a Color
Select a color from the color menu.  Masks apply only to 
edges where the selected color predominates.  To create a 
mask that applies to all colors, select All.

Intensity The amount the contrast of edges will be increased.

Halo 
Width

The size of the area that will be affected.  The greater 
the halo width, the wider edges will appear.  Too large a 
value for halo width will produce a “halo” along edges 
in the image.

Threshold

The limit at which sharpening will be applied.  If the 
threshold is zero, sharpening will apply to all pixels in the 
image.  Increasing the threshold increases the amount of 
contrast that must be present between pixels before the 
mask will be applied, with the result that only more dis-
tinctly contrasting edges will be affected.

Step 3—Check the Results
To compare the effects of the Unsharp Mask with the un-
modifi ed image, click the “Apply” button at the top left 
corner of the “Unsharp Mask” palette to turn the effects of 
Unsharp Mask on or off.

Step 4—Create Additional Masks
Repeat steps 1–3 to create additional masks for different 
colors.  New masks will be added to the end of the Unsharp 
Mask list.  Masks apply in the order listed.  To change the 
order, select a mask in the Unsharp Mask list and click  
to move it up in the list or  to move it down.  To delete a 
mask, select it and click the  button.Step 2—Set Intensity, Halo Width, and Threshold

Use the sliders or enter values directly in the text boxes to 
their right.
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The Unsharp Mask Settings Menu
Clicking the triangle in the top right corner of the “Unsharp Mask” palette displays the Unsharp Mask settings menu.

Option Description

Reset to User Unsharp Mask Settings
Restore the default Unsharp Mask settings created with the Set User Settings option in the scan 
window settings menu (  17).

Reset to Default Unsharp Mask Settings Delete all masks in the Unsharp Mask list.

Export Unsharp Mask Settings…
Export current settings to a fi le in a location of your choice.  Unsharp Mask settings fi les have the 
extension “.num”.

Import Unsharp Mask Settings… Import settings created using the Export Unsharp Mask Settings… option.

Delete Unsharp Mask Settings…
Delete settings created using the Save Unsharp Mask Settings… option.  A dialog will be dis-
played where the settings to be deleted can be selected by name.

Save Unsharp Mask Settings…

Save current Unsharp Mask settings under a user-specifi ed name.  These settings will be added to 
the end of the Unsharp Mask settings menu, where they can be recalled by selecting the desired 
settings by name.

Copy to Clipboard

Copy current Unsharp Mask settings to the clipboard.  These settings can then be pasted into the 
“Unsharp Mask” palette for another window by activating the window and selecting Paste from 
the Edit menu.
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The LCH EditorThe LCH Editor
Editing ColorsEditing Colors

The LCH Editor models color using three components: Light-
ness (brightness), Chroma (color saturation, or vividness), 
and Hue.  Each component has its own edit display.  Lu-
minosity and chroma are represented by curves, which can 
be edited in much the same way as the tone curves in the 
“Curves” palette.  Steepening the luminosity curve increases 
the difference between bright and dark portions of the 
image, increasing contrast.  Steepening the chroma curve 
increases color saturation, making colors more vivid.  Both 
editors feature histograms, auto contrast, and white, black, 
and gray-point sliders.  Output sliders are also available to 
edit the maximum and minimum values for output.

  The “LCH Editor” PaletteThe “LCH Editor” Palette
The “LCH Editor” palette can be used in both the scan window and in 
image windows.

  The “Apply” ButtonThe “Apply” Button
Changes to the LCH Editor only apply when the button at the top left 
corner of the “LCH Editor” palette is checked.  When this button is 
checked, changes to settings will be refl ected in the image in the active 
window.  The box can be checked and unchecked for a quick “before-
and-after” comparison to determine whether changes to settings are 
having the desired effect.

The hue editor features unique controls for unparalleled fl ex-
ibility when editing colors.  Using this tool, a specifi c range 
of input colors can be mapped to another range of output 
colors.  This allows all the reds in the image, for example, to 
be made more orange, or even green or blue.

The desired editor is selected from the menu at the top of 
the “LCH Editor” palette.

  Nikon Color Management (Nikon Color Management (  78) 78)
The LCH Editor is only available when the Nikon Color Management Sys-
tem (CMS) is on.  If Nikon CMS is off, the tools in the “LCH Editor” pal-
ette will be disabled.  To use the LCH Editor with a color space that has 
the same gamut as uncalibrated RGB data obtained directly from the 
scanner, turn CMS on and select the Scanner RGB color-space profi le.

Editor menu

Apply button
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The Lightness Editor
Although it affects brightness rather than color, editing lumi-
nosity has a similar effect to editing the master curve in the 
“Curves” palette.  Steepening the curve increases the differ-
ence between light and dark areas of the image, increasing 
contrast.  Moving the gray point alters the brightness of mid-
tones while preserving detail in highlights and shadows.

Gray-point 
slider

Output level 
sliders

White-point sliderBlack-point slider Input/output 
levels

  Editor Selection ShortcutsEditor Selection Shortcuts
The editor can also be selected using the following shortcuts:
• Ctrl Shift 1 (Windows)/  option 1 (Macintosh)

Luminosity editor
• Ctrl Shift 2 (Windows)/  option 2 (Macintosh)

Chroma editor
• Ctrl Shift 3 (Windows)/  option 3 (Macintosh)

Hue editor

Item Description

Histogram

Shows the distribution of pixels of different luminosi-
ties in the input.  The horizontal axis corresponds to 
luminosity (in the range 0–255), the vertical axis to the 
number of pixels.

Output
level sliders

Choose the maximum and minimum values for out-
put.

Black-point 
slider Choose the minimum input level.

Gray-point 
slider Set the gray point (gamma value).

White-point 
slider Choose the maximum input level.

Input/output 
levels

Input and output levels for the point under the cursor 
in the curve edit display.

Click to view the luminosity distribution for the fi nal 
image.  Click again to view the input luminosity distri-
bution.

Restore the luminosity curve to linear.

Restore all curves in the LCH Editor to linear.

Set maximum and minimum input levels to exclude val-
ues for 0.5% of the brightest and darkest pixels in the 
crop.  The percentage of pixels excluded can be adjust-
ed in the “Advanced Color” category of the “Prefer-
ences” dialog (  101).

Histogram
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The Chroma Editor
The chroma editor is a useful tool for adjusting color satura-
tion.  Steepening the curve increases saturation in the af-
fected range, making colors more vivid.  Flattening the curve 
results in fl atter, less vivid colors.  Moving the gray point to 
the left makes the image as a whole more vivid, while mov-
ing it to the right “averages out” differences between colors, 
making the image grayer.  One effective way to make full use 
of the scanner’s dynamic range is to steepen the curve in the 
portions of the histogram that contain the greatest number 
of pixels, while leaving colors corresponding to a neutral gray 
unaffected.

Item Description

Histogram

Shows the distribution of pixels of different chromas in 
the input.  The horizontal axis shows chroma, the verti-
cal axis the number of pixels.

Output
level sliders

Choose the maximum and minimum values for out-
put.

Black-point 
slider Choose the minimum input level.

Gray-point 
slider Set the gray point (gamma value).

White-point 
slider Choose the maximum input level.

Input/output 
levels

Input and output levels for the point under the cursor 
in the curve edit display.

Click to view the chroma distribution for the fi nal im-
age.  Click again to view the input chroma distribu-
tion.

Restore the chroma curve to linear.

Restore all curves in the LCH Editor to linear.
Gray-point 
slider

Output level 
sliders

White-point sliderBlack-point slider Input/output 
levels

Histogram
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The Hue Editor
The controls for editing hue are unique, consisting of a rain-
bow-colored background bisected by a horizontal line which 
represents the hues (colors) in the original image (input col-
ors).  Superimposed on this line is another horizontal line 
representing the colors in the image after editing (output 
colors).  Before editing, the input line is the same as the 
output line, so that reds in the input are reproduced as reds 
in the fi nal image.  By changing the shape of hue curve, the 
user can map input colors to different output colors over a 
selected portion of the color range.

To edit the hue curve, click once in the edit window to ac-
tivate the hue editor, then click the point on the curve over 
the hue you want to edit.  Drag this point up or down until it 
intersects with the desired output color.

Item Description

Width slider

Adjust the width of the curve that passes through the 
selected point, increasing or decreasing the range of 
adjacent hues affected by the change.

Scale button

Click to change the vertical scale from 60 ° through 
120 ° to 180 ° and back again (the degrees in this scale 
refer to a 360 ° color wheel).  Increasing the scale in-
creases the range of hues visible in the display, while 
decreasing the scale increases precision.

Output slider Map all input colors to different output colors.

Restore the hue curve to linear.

Restore all curves in the LCH Editor to linear.

Output slider

Scale buttonWidth slider

To determine the hue of a specifi c pixel, move the cursor 
over the image.  The point corresponding to the hue of the 
pixel under the cursor will be highlighted on the input line.
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The LCH Editor Settings Menu
Clicking the triangle in the top right corner of the “LCH Editor” palette displays the LCH Editor settings menu.

Option Description

Reset to User LCH Curve Settings
Restore the default LCH Editor settings created with the Set User Settings option in the scan window 
settings menu (  17).

Reset to Default LCH Curve Settings Reset all curves in the LCH Editor to linear.

Export LCH Curve Settings…
Export current settings to a fi le in a location of your choice.  LCH Editor settings fi les have the exten-
sion “.nlv”.

Import LCH Curve Settings… Import settings created using the Export LCH Curve Settings… option.

Delete LCH Curve Settings…
Delete settings created using the Save LCH Curve Settings… option.  A dialog will be displayed 
where the settings to be deleted can be selected by name.

Save LCH Curve Settings…

Save current LCH Editor settings under a user-specifi ed name.  These settings will be added to the 
end of the LCH Editor settings menu, where they can be recalled by selecting the desired settings by 
name.

Copy to Clipboard
Copy current LCH Editor settings to the clipboard.  These settings can then be pasted into the “LCH Edi-
tor” palette for another window by activating the window and selecting Paste from the Edit menu.
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Digital ICEDigital ICE44 Advanced (Digital ICE quad Advanced) Advanced (Digital ICE quad Advanced)
Digital ICE, Digital ROC, Digital GEM, Digital DEEDigital ICE, Digital ROC, Digital GEM, Digital DEE

The “Digital ICE4 Advanced” palette controls the Digital DEE 
(9000 ED, 5000 ED, and COOLSCAN V ED only), Digital 
ICE, Digital ROC, and Digital GEM functions built into Nikon 
scanners to reduce the effects of scratches, dust, fading, fi lm 
grain, and under- or over-exposure.

  The “Digital ICEThe “Digital ICE44 Advanced” Palette Advanced” Palette
The “Digital ICE4 Advanced” palette is only available when the scan 
window is active.

The following functions are available:

Function Description

Digital ICE
Reduces the effect of dust and scratches when 
the image is scanned.  62

Digital ROC
Processes images digitally to restore colors lost 
through fading.  63

Digital GEM
Processes images digitally to reduce the effects 
of fi lm grain.  64

Digital DEE

Enhances detail in underexposed or overex-
posed areas of the image (9000 ED, 5000 ED, 
and COOLSCAN V only).

 65

  Scanning Glass Microscope SlidesScanning Glass Microscope Slides
Turn Digital ICE4 Advanced off when scanning glass microscope slides in 
the FH-G1 or FH-8G1 medical holders (available separately).  Digital ICE4 
Advanced may fail to produce the desired results with glass microscope 
slides.
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Digital ICE—Correcting for Scratches and Dust
Digital ICE (Image Correction and Enhancement) reduces 
the effects of dust and scratches when images are scanned.  
To use Digital ICE, select Enable Digital ICE and choose 
On(Normal) or On(Fine) from the Digital ICE menu.

Option Description

On(Normal) 

On(Fine)

Use this setting to remove very thin scratches or dust 
that is barely visible.  Note that the overall sharpness of 
the image may be reduced.

The image is processed digitally to remove the effects 
of scratches and dust.

To view the effects any changes to Digital ICE settings, click 
the Preview button in the scan window (the preview image 
can not be updated using the Redraw button, which can 
only be used with Digital ROC, Digital GEM, and Digital DEE).  
The effects of Digital ICE are refl ected in both the “Natural” 
and “Processed” panels.Enable Digital 

ICE check box

  Scanning TimeScanning Time
Scanning times will increase when Digital ICE is enabled.  Turn Digital 
ICE off to reduce scanning times.

  The Information PanelThe Information Panel
When Digital ICE is enabled, the option selected in the Digital ICE menu 
is displayed in the scan window information panel.  A warning icon ( ) 
will be displayed if the preview image has not been updated to refl ect 
changes to Digital ICE settings.

  Film NegativesFilm Negatives
Noise may appear if Digital ICE is used to process overexposed images 
or images that have acquired very vivid colors through the developing 
process.  The best results will be obtained in correctly exposed images 
that have been developed normally. 

  Monochrome FilmMonochrome Film
Digital ICE can not be used with monochrome fi lm unless the fi lm has 
been developed in color.

  Kodachrome FilmKodachrome Film
Digital ICE is not recommended when scanning Kodachrome fi lm with 
the 8000 ED, 4000 ED, or COOLSCAN IV ED. When scanning Koda-
chrome fi lm with the 9000 ED, 5000 ED, or COOLSCAN V ED, select 
Kodachrome in the fi lm type menu. Depending on the frame scanned, 
blurring or localized loss of detail may occasionally result when Koda-
chrome fi lm is scanned with the 5000 ED or COOLSCAN V ED.

The Tool Chest — Digital ICE4 Advanced
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Digital ROC—Restoring Faded Colors
Digital ROC (Reconstruction of Color) digitally restores colors 
lost through fading of the original fi lm.  To use Digital ROC, 
select Enable Post Processing and choose a value for color 
reconstruction using the Digital ROC slider or by entering a 
value between 0 (Digital ROC off) and 10 (maximum effect) 
in the text box to its right.  The default setting is 5.

To preview the image at the new settings, click the Redraw 
button.  If the desired results are not achieved, adjust set-
tings and click the Redraw button again.

  Scanning and Preview TimesScanning and Preview Times
Scanning and preview times will increase when Digital ROC is enabled.  
To reduce scanning and preview times, remove the check from the En-
able Post Processing check box.

  Monochrome Film/Grayscale ImagesMonochrome Film/Grayscale Images
Digital ROC may add color to monochrome images or images scanned 
in grayscale.

  Digital ROCDigital ROC
The status of Digital ROC is shown in the scan window information 
panel.  A warning icon ( ) will be displayed if the preview image has 
not been updated to refl ect changes to Digital ROC settings.  Digital 
ROC is not available when the FH-816 or FH-8G1 is used with the 9000 
ED or 8000 ED, or when the FH-G1 is used with the 5000 ED, 4000 ED, 
COOLSCAN V ED, or COOLSCAN IV ED.
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Digital GEM—Reducing Film Grain
Digital GEM (Grain Equalization Management) digitally pro-
cesses images to reduce the effects of fi lm grain.  To use 
Digital GEM, select Enable Post Processing and choose a 
value for grain equalization using the Digital GEM slider or 
by entering a value between 0 (Digital GEM off) and 4 (maxi-
mum effect) in the text box to its right.  The default setting 
is 3.

To preview the image at the new settings, click the Redraw 
button.  If the desired results are not achieved, adjust set-
tings and click the Redraw button again.

  Scanning and Preview TimesScanning and Preview Times
Scanning and preview times will increase when Digital GEM is enabled.  
To reduce scanning and preview times, remove the check from the En-
able Post Processing check box.

  Digital GEMDigital GEM
The status of Digital GEM is shown in the scan window information 
panel.  A warning icon ( ) will be displayed if the preview image has 
not been updated to refl ect changes to Digital GEM settings.  Digital 
GEM is not available when the FH-816 or FH-8G1 is used with the 9000 
ED or 8000 ED, or when the FH-G1 is used with the 5000 ED, 4000 ED, 
COOLSCAN V ED, or COOLSCAN IV ED.
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Digital DEE—Enhancing Detail in Shadows and Highlights
Digital DEE (Dynamic Exposure Extender) reveals details in 
shadows and highlights, correcting for underexposure in 
back-lit subjects or shaded areas and for overexposure in 
brightly lit areas.  Digital DEE is only available with 9000 ED, 
5000 ED, and COOLSCAN V ED fi lm scanners.

Enhancing Details in Shadows
To enhance details in shadows, select Enable Digital DEE 
and adjust shadow brightness using the Shadow Adjust-
ment slider or by entering a value between 1 and 100 in the 
text box to its right.  The larger the value, the brighter shad-
ows in the image will be.  The default setting is 50.

To preview the image at the new settings, click the Redraw 
button.  If the desired results are not achieved, adjust set-
tings and click the Redraw button again.

  Digital DEEDigital DEE
The status of Digital DEE is shown in the scan window information 
panel.  A warning icon ( ) will be displayed if the preview image has 
not been updated to refl ect changes to Digital DEE settings.  Digital DEE 
is not available when the FH-816 or FH-8G1 is used with the 9000 ED, 
or when the FH-G1 is used with the 5000 ED or COOLSCAN V ED.

  Scanning and Preview TimesScanning and Preview Times
Scanning and preview times will increase when Digital DEE is enabled.  
To reduce scanning and preview times, remove the check from the En-
able Digital DEE check box.

  Medium-Format Film (9000 ED Only)Medium-Format Film (9000 ED Only)
When using Digital DEE to scan medium-format fi lm under Windows, 
adjust “Crop” palette settings so that fi le size is 169 MB or less.  A fi le of 
169 MB is equivalent to a full frame of 6 × 9 fi lm (crop size 6588 × 4482 
pixels) scaled to 100% at 2000 dpi.

  Selecting a CropSelecting a Crop
When using Digital DEE, select a crop that excludes the frame borders 
and other unexposed areas of the fi lm.

  Monotone ShadowsMonotone Shadows
Digital DEE has no effect if details in shadows have been totally obliter-
ated, leaving shadows a single, uniform color.

After processingBefore processing
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Enhancing Details in Highlights
Digital DEE can also be used to reveal details in highlights 
where the background is much brighter than the subject or 
the subject much brighter than the background.  To enhance 
details in highlights, select Enable Digital DEE and click 
More.

To preview the image at the new settings, click the Redraw 
button.  If the desired results are not achieved, adjust set-
tings and click Redraw again.

Adjust highlights using the Highlight Adjustment slider or 
by entering a value between 1 and 100 in the text box to 
its right.  Increasing highlight adjustment increases contrast 
in highlights, while decreasing highlight adjustment has the 
opposite effect.  The default value is 1.

After processingBefore processing

  Monotone HighlightsMonotone Highlights
Digital DEE has no effect if details in highlights have been totally obliter-
ated, leaving highlights a single, uniform color.
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Defi ning “Shadows” and “Highlights”
The Threshold slider in the detailed view of the “Digital 
DEE” panel determines the border between shadows and 
highlights.

Moving the slider to the right or entering a higher value in 
the Threshold text box increases the range of tones affected 
by the Shadow Adjustment slider and reduces the range of 
tones affected by the Highlight Adjustment slider.

Try increasing the threshold value if shadow brightness fails 
to brighten shadows in the desired tone range, or if highlight 
adjustment is affecting too great an area.

Moving the slider is to the left or entering a lower value in the 
Threshold text box increases the range of tones affected by 
the Highlight Adjustment slider and reduces the range of 
tones affected by the Shadow Adjustment slider.

Try decreasing the threshold value if highlight adjustment 
fails to increase contrast in the desired tone range, or if 
shadow brightness is affecting too great an area.

Threshold 
slider and 
text box

Shadows

Threshold

Highlights

Tone range affected by
Shadow Adjustment

Tone range affected by
Highlight Adjustment

Shadows

Threshold

Highlights

Tone range affected by
Shadow Adjustment

Tone range affected by
Highlight Adjustment

  ThresholdThreshold
Ideally, the threshold for shadow adjustment should be twenty to forty 
greater than the highest of the R and G values in the brightest shadows.  
The threshold for highlight adjustment should be twenty to forty less 
than lowest of the R and G values in the dark-
est highlights.  To choose a threshold that can 
be used for both shadows and highlights, enter 
the average of the highest value (R or G) in the 
brightest shadows and the lowest value (R or G) in 
the darkest highlights.  Color values can be deter-
mined by moving the cursor over the image and 
observing the R and G values in the scan window 
information panel.

The Tool Chest — Digital ICE4 Advanced
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The Digital ICE4 Advanced Settings Menu
Clicking the triangle in the top right corner of the “Digital ICE4 Advanced” palette displays the Digital ICE4 Advanced settings 
menu.

Option Description

Reset to User Digital ICE4

Advanced Settings

Reset to Default Digital ICE4

Advanced Settings 

Export Digital ICE4 Advanced 
Settings…

Import Digital ICE4 Advanced 
Settings… 

Delete Digital ICE4 Advanced 
Settings…

Save Digital ICE4 Advanced
Settings…

Copy Digital ICE4 Advanced
Settings to Clipboard

(Macintosh only) 

Copy current Digital ICE4 Advanced settings to the clipboard.  These settings can then be pasted into the 
“Digital ICE4 Advanced” palette by selecting Paste from the Edit menu.  

Save current Digital ICE4 Advanced settings under a user-specifi ed name.  These settings will be added to 
the end of the Digital ICE4 Advanced settings menu, where they can be recalled by selecting the desired 
settings by name.

Delete settings created using the Save Digital ICE4 Advanced Settings… option.  A dialog will be dis-
played where the settings to be deleted can be selected by name.

Import settings created using the Export Digital ICE4 Settings… option. 

Export current settings to a fi le in a location of your choice.  Digital ICE4 Advanced settings fi les have the 
extension “.nla”.

Turn off all Digital ICE4 Advanced functions and restore all sliders to default settings.  

Restore the default Digital ICE4 Advanced settings created with the Set User Settings option in the scan 
window settings menu (  17).

Windows Macintosh

The Tool Chest — Digital ICE4 Advanced
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Analog GainAnalog Gain
Controlling the Scanner’s Light SourceControlling the Scanner’s Light Source

The “Analog Gain” palette is used to adjust color by modify-
ing exposure for the colored elements in the scanner’s light 
source.  Gain is measured in Exposure Values (EVs), the same 
unit used for measuring exposure compensation on many 
cameras.

Analog gain 
sliders and 
text boxes

Redraw
button

Reset
button

  The “Analog Gain” PaletteThe “Analog Gain” Palette
The “Analog Gain” palette is only available when the scan window is 
active.

  Exposure ValuesExposure Values
Exposure Values are a measure of the quantity of light that falls on the 
scanning element (Charge- Coupled Device, or CCD).  At +1 EV, the 
CCD is exposed to twice the normal amount of light, while at –1 EV, the 
amount of light is halved.  EVs are sometimes referred to as “steps.”

  SmearSmear
Choosing too high a value for exposure may produce “smear” or other 
defects in the scanned image.

  Analog GainAnalog Gain
The status of analog gain is shown in the scan window information 
panel.  A warning icon ( ) will be displayed if the preview image has 
not been updated to refl ect changes to analog gain.

The “Analog Gain” palette contains the following items:

Item Description

Master

Adjust exposure for all elements by dragging the slider 
or by entering a value between –2.00 and +2.00 in the 
text box to its right.

Red, Green, 
Blue

Adjust exposure for the red, green, and blue elements 
by dragging the sliders or by entering values between 
–2.00 and +2.00 in the text boxes to their right.

Redraw
Update the preview image to refl ect changes to ana-
log gain.

Reset Reset all analog gain sliders to ±0.
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Scan Image Enhancer (9000 ED, 5000 ED, COOLSCAN V ED Only)Scan Image Enhancer (9000 ED, 5000 ED, COOLSCAN V ED Only)
Automatic Color, Brightness, and Contrast AdjustmentAutomatic Color, Brightness, and Contrast Adjustment

The Scan Image Enhancer automatically adjusts brightness 
and color saturation during scanning to produce an image 
with optimal contrast.  It is only available with 9000 ED, 
5000 ED, and COOLSCAN V ED fi lm scanners.

To use the Scan Image Enhancer, select Enable Scan Image 
Enhancer in the “Scan Image Enhancer” palette.

To preview the effects of the Scan Image Enhancer, click 
Redraw.

  The “Scan Image Enhancer” PaletteThe “Scan Image Enhancer” Palette
The “Scan Image Enhancer” palette is only available when the scan 
window is active.

  Scan Image EnhancerScan Image Enhancer
The status of the Scan Image Enhancer is shown in the scan window 
information panel.  A warning icon ( ) will be displayed if the preview 
image has not been updated to refl ect changes to the Scan Image En-
hancer.

  Scanning TimeScanning Time
Scanning times may increase slightly when the Scan Image Enhancer is 
enabled.

  Dark ImagesDark Images
If the image is dark, the Scan Image Enhancer may have no effect or 
may make the scanned image darker.  Turn the Scan Image Enhancer off 
if it fails to produce the desired results.

Enable Scan 
Image

Enhancer 
check box

Redraw
button
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Scanner ExtrasScanner Extras
Controlling Scanner SettingsControlling Scanner Settings

The options available in the “Scanner Extras” palette vary with the model of scanner connected and the fi lm holder or 
adapter in use.

“Scanner Extras” palette for 9000 ED
with FH-835S fi lm holder

“Scanner Extras” palette for 5000 ED
with SA-21 adapter

  The “Scanner Extras” PaletteThe “Scanner Extras” Palette
The “Scanner Extras” palette is only available when the scan window is active.
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Item DescriptionScanner

Reposition fi lm to match the scan position.Strip fi lm offset
All (SA-21, SA-30,

FH-869S, FH-869G only)

Focus scanner manually using slider or by direct text entry.
Manual focus
adjustment

Perform autofocus when slide is inserted in MA-21/MA-20 (S) (5000 ED, 4000 ED, COOLSCAN 
V ED, COOLSCAN IV ED).  When holder is inserted in 9000 ED or 8000 ED, perform autofocus 
on fi rst frame (FH-869S, FH-869G, FH-869GR excluded).

Perform
autofocus when 
fi lm is inserted

All

Recalibrate scanner when fi lm has been left in device for extended periods.Calibration

Control amount of color information acquired for each pixel (scan bit depth).Pixel data size

Choose crop settings to match different APS (IX-240) aperture settings.Crop choices

5000 ED, 4000 ED, 
COOLSCAN V ED,
COOLSCAN IV ED

(IA-20 (S) only)

Increase accuracy by increasing the number of passes the scanner makes over the image.
Multi-sample 

scanning
9000 ED, 8000 ED,
5000 ED, 4000 ED

Select Super Fine Scan to perform a single-line scan instead of the normal three-line scan.CCD scan mode9000 ED, 8000 ED

Choose the number of slides scanned each time the Scan button is clicked.Slide feeder scan
5000 ED, 4000 ED

(SF-210/SF-200 (S) only)

The “Scanner Extras” palette contains the following options:
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Strip Film Offset
This is option is used to 
position the fi lm in the 
scan aperture.  It is only 
available with the SA-21, 
FH-869S, and the optional 
SA-30 and FH-869G.

To use this option, the thumbnail drawer must be open with 
thumbnails displayed.  Select the desired thumbnail and ad-
just its position using the Boundary Offset slider or by en-
tering a value in the text box to its right.  If the right edge of 
the thumbnail is cut off, move the slider to the right or enter 
a larger value to bring it into position; if the left edge is cut 
off, move the slider to the left or enter a smaller value.  Note 
that the direction of adjustment changes when thumbnails 
are fl ipped or rotated.

To view the effects of changes to the boundary offset, click 
the Reload Thumbnail button and check the results in the 
thumbnail drawer.  The changes will not be refl ected in the 
preview area until the Preview button is clicked.

  Strip Film OffsetStrip Film Offset
Numerical boundary offset ranges are shown below.

5000 ED, 4000 ED, COOLSCAN V ED, COOLSCAN IV ED

First frame Subsequent frames

0–144 -144 – 144

Medium-format fi lm (9000 ED, 8000 ED)

Frame size

6 × 4.5

6 × 6

6 × 7

6 × 8

6 × 9

Subsequent frames

-69 – 69

-93 – 93

-114 – 114

-127 – 127

-137 – 137

First frame*

0–69

0–93

0–114

0–127

0–137

* Small negative values may be possible with the fi rst frame of medium-
format fi lm.

Manual Focus Adjustment
Use manual focus adjustment 
when the desired results can 
not be achieved using auto-
focus.  Adjust focus using the 
Position slider or by entering a value in the text box to its 
right, then click the Preview button in the scan window to 
refocus the scanner.  The new focus position will be used un-
til the next time fi lm is inserted or Nikon Scan is restarted.  To 
focus the scanner automatically, click the autofocus button in 
the scan window control area.
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Perform Autofocus When Film Is Inserted
If this option is selected when the 
MA-21/MA-20 (S) slide-mount 
adapter is inserted in the 5000 
ED, 4000 ED, COOL SCAN V ED, or COOLSCAN IV ED, an 
autofocus operation will automatically be performed when 
a slide is inserted.

If this option is selected when 
the 9000 ED or 8000 ED is con-
nected, an autofocus operation 
will be performed on the fi rst frame when a fi lm holder is in-
serted (an autofocus operation will not be performed when 
the FH-869S, FH-869G, or FH-869GR is inserted).

Calibration
If the scanner is left on for an extended 
period, the temperature inside the scanner 
will rise and the scanner may need to be 
recalibrated.  Click Calibrate to recalibrate 
the scanner.

If the MA-21 or MA-20 (S) is inserted, remove any slides 
from the adapter before recalibrating.  Users of the IA-20 
(S) will be prompted to rewind the fi lm before calibration 
begins.  Film will automatically be ejected from the SA-21, 
SA-30, 9000 ED, or 8000 ED before calibration begins, and 
will automatically be reloaded when calibration is complete.

  The Status LEDThe Status LED
The scanner status LED will blink while the scanner is being recalibrated.  
Do not perform any additional operations in Nikon Scan until the status 
LED has stopped blinking.
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Pixel Data Size
The option selected in the Scan Bit 
Depth menu determines the num-
ber of bits acquired per color chan-
nel for each pixel in the image.  The options available depend 
on the scanner used:
• 9000 ED, 5000 ED: 16 bits, 8 bits
• COOLSCAN V ED, 8000 ED, 4000 ED: 14 bits, 8 bits
• COOLSCAN IV ED: 12 bits, 8 bits

  Bit Depth, Color, and File SizeBit Depth, Color, and File Size
Scanning at a bit depth of eight bits yields 256 shades per pixel for each 
component channel of the current color model (if the image is three-
color RGB, the result is 24-bit color, which can express roughly 16.7 
million different color values).  The maximum bit depth depends on the 
scanner connected:
• 9000 ED, 5000 ED: 16 bits (65,536 shades per channel)
• COOLSCAN V ED, 8000 ED, 4000 ED: 14 bits (16,348 shades per chan-

nel)1

• COOLSCAN IV ED: 12 bits (4,096 shades per channel)1

Scanning at the maximum bit depth results in larger fi les but increases 
accuracy.

1 Images scanned at fourteen and twelve bits are converted to sixteen 
bits when opened in the host application.

IX240 Crop Choices
The following crop choices are available 
when the optional IA-20 (S) APS (IX-240) 
fi lm adapter is inserted in the 5000 ED, 
4000 ED, COOLSCAN V ED, or COOLSCAN 
IV ED:

Crop choice Description

Classic

The size of the initial crop is adjusted for the “classic” 
APS setting, with a width-height ratio the same as 35-
mm fi lm (3 : 2).

Wide
The size of the initial crop is adjusted for the “wide” 
APS setting, with a width-height ratio of 16 : 9.

Panorama
The size of the initial crop is adjusted for the “panora-
ma” APS setting, with a width-height ratio of 3 : 1.
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Multi-Sample Scanning
In multi-sample scanning (available 
only with the 9000 ED, 8000 ED, 
5000 ED, and 4000 ED), the scanner 
makes multiple passes over the image and averages the results 
to reduce the effects of electronic “noise,” producing more 
accurate reproductions with smoother changes in tone.

To use multi-sample scanning, select the desired setting 
from the Mode menu:

Mode DescriptionNo. of passes

Super Fine (16×)
Precision increased by equivalent of 
four bits per channel.16

More Fine (8×)
Precision increased by equivalent of 
three bits per channel.8

Fine (4×)
Precision increased by equivalent of 
two bits per channel.4

Good (2×)
Precision increased by equivalent of 
one bit per channel.2

Normal (1×) Multi-sample scanning off.1

  Scanning TimeScanning Time
Scanning time increases in proportion to the number of passes.

CCD Scan Mode
This option is available only with 9000 
ED and 8000 ED fi lm scanners.  To speed 
scanning, these scanners use a three-line 
CCD.  Although the scanner automatically 
compensates for slight differences in output between each 
line, the very small differences that do remain could cause 
a drop in image quality when, for example, the image is 
processed by sharply steepening curves to increase contrast.  
This can be prevented by selecting Super Fine Scan to scan 
the image with a single line (note that scanning times will 
triple).  Super Fine Scan produces no noticeable improve-
ment when scanning images with a standard tone curve.

Slide Feeder Scan
This option is available when an optional 
SF-210 or SF-200 (S) slide adapter is 
used with the 5000 ED or 4000 ED.  En-
ter the number of slides to be scanned 
in the Feed Images text box.  This is the number of slides 
that will be scanned in sequence when the Scan button is 
clicked.  To scan all the slides in the feeder, enter a large value 
(the maximum value is 99).
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Nikon Color Management (  78) *

Single Scan (  95)

Color Management (  84)

Gamma (  82)

File Locations (  94)

Batch Scan (  96)

File Saving (  99)

Automatic Actions (  100)

Advanced Color (  101)

Grid Settings (  105)

  Nikon Scan MenusNikon Scan Menus
When Nikon Scan is used as a “stand-alone” application, the “Preferences” dialog can also be accessed by selecting Preferences… from the Edit 
menu (in Mac OS X, select Preferences… from the Nikon Scan application menu).

Preferences
Fine-Tuning Nikon Scan

The settings in the “Preferences” dialog are used to fi ne-tune the controls in the scan window.  To view the “Preferences” 
dialog, click the Prefs button in the control area of the scan window.

The settings in the “Preferences” dialog are divided into the categories shown below.  Click the links for more information.

Prefs 
button

Categories

* Read “Nikon Color Management” before reading 
the “Gamma” and “Color Management” sec-
tions.

Preview Settings (  103)
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Nikon Color ManagementNikon Color Management
Keeping Colors TrueKeeping Colors True

The Nikon Color Management System, or Nikon CMS, en-
 sures that image data from Nikon scanners are re pro duced 
consistently and accurately on monitors or print ers.  With this 
pow er ful tool, colors can be manipulated in a cal i brat ed RGB 
color model before the data are passed to the host applica-
tion.  Profi les detailing the color char ac ter is tics of the chosen 
color model and the output de vice (mon i tor or print er) en-
sure that colors will be reproduced ac cu rate ly in al most any 
operating environment.

Nikon CMS involves two categories of preferences, one 
(“Gamma”) for use when Nikon CMS is off and the other 
(“Color Man age ment”) for use when Nikon CMS is on.  
“Gamma” specifi es how data from the scanner will be mod-
 i fi ed for display on the monitor.  Because monitor profi les 
can not be used when Nikon CMS is off, this adjustment 
must be made manually.  “Color Management” is used to 
turn Nikon CMS on and off and select the profi les for use 
with the monitor and with the CMYK and calibrated RGB 
color models when Nikon CMS is on.

  Turning Nikon CMS OffTurning Nikon CMS Off
In general, much better results can be achieved with Nikon CMS on.  It 
may however be necessary to turn color management off to:

• Speed processing
If the computer has a slow CPU, the processing required for color 
management may result in longer scan times.  Try turning color man-
agement off for reduced scan times.

• Edit data from the scanner directly
Advanced users may want to turn Nikon CMS off to edit uncalibrated 
RGB data from the scanner.

  CMYKCMYK
Images can not be scanned in CMYK.  If CMYK data are required, con-
vert images to CMYK before saving them to disk.  Note that images 
can only be saved in CMYK if Nikon CMS is on (Nikon CMS is on by 
default).
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How Nikon CMS Works
Color-Space Profi les
Separate profi les are avail able for the RGB and CMYK color 
models.  Nikon Scan comes with a selection of profi les for 
the RGB color model, while CMYK profi les for color print ers 
are usually pro vid ed by the man u fac tur er.  Color-space pro-
 fi les are used when editing images in the scan win dow and 
when making the fi nal scan.

Monitor Profi les
Monitor profi les are usually provided by the manufacturer, 
although profi les for some common monitor types may be 
included with the computer operating system.  Monitor 
profi les apply when images are displayed on a monitor, for 
example when an image is displayed in the preview area or 
an image win dow.

  Creating Monitor Profi lesCreating Monitor Profi les
If desired, Adobe Photoshop can be used to create a monitor profi le for 
a specifi c environment.  This profi le can then be used in Nikon Scan.  
For information on creating monitor profi les, see the doc u men ta tion 
provided with Adobe Photoshop.  This option is not avail able in Adobe 
Photoshop LE.

When image data are passed from an input device, such as 
a scanner, to an output device, such as a monitor or printer, 
color management ensures that the image displayed on the 
output device “looks the same” as the original.  To accom-
plish this task, the color management system must have 
information about the color characteristics of both the input 
and output devices, as well as the color space used for edit-
ing.  The fi les containing this in for ma tion are called “ICC pro-
fi les.”  Nikon Scan uses the fol low ing three types of profi le:

Input Profi les
Input profi les provide information on the input device, i.e., 
the Nikon scanner.  Fixed pro fi les de tail ing the color char-
 ac ter is tics of sup port ed Nikon scanners are provided with 
Nikon Scan.  An input profi le is se lect ed au to mat i cal ly based 
on the model of scan ner used and the type of media (pos-
 i tive or negative) being scanned.
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Scan

Scan

Preview

The Scanning Process
The illustration below shows the role Nikon CMS plays in 
the scanning process.  CMS profi les are shown in blue, user 
op er a tions in red.

When Nikon CMS is on, uncalibrated RGB image data from 
the scan ner are converted to grayscale or calibrated RGB, 
de pend ing on the color model selected in the scan window.  
RGB data are processed according to the profi le selected for 
the calibrated RGB color space.  These data are stored in 
mem o ry so that the color model can be changed with out 
per form ing an oth er pre view.  Any changes made using the 
color enhancement and Unsharp Mask tools also ap ply to 
these data.  When the im age is dis played in the pre view win-
 dow, the mon i tor pro fi le is used to ensure that the preview 
image is as true as pos si ble to the data in mem o ry.

When the Scan button is clicked to perform the fi nal scan, 
the scan data are processed according to the selected color-
space profi le and any changes that were made using the 
color en hance ment and Unsharp Mask tools in the scan 
win dow.  The data are then trans ferred to the host ap pli -
ca tion.  Where pos si ble, the color-space pro fi le is trans ferred 
to the host ap pli ca tion to geth er with the im age data.  The 
TWAIN in ter face used in Windows, how ev er, does not al low 
profi les to be passed to an oth er ap pli ca tion, with the result 
that under Win dows the pro fi le is only transferred to the 
host when Nikon Scan is used as a “stand-alone” application 
(note that profi le information is lost when the image is saved 
in a format such as BMP that does not allow the profi le to 
be recorded).  When im ag es are dis played in im age win dows 
in Nikon Scan, the monitor profi le en sures that the image on 
the screen refl ects the orig i nal as close ly as pos si ble.
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Scan

Scan

PreviewBefore preview

Gamma adjustment

Preview
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Preview 
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Scanning with Nikon CMS Off
If Use Nikon Color Management System is not selected in 
the “Color Management” category, profi les can not be used 
to ensure that the data from the scanner are reproduced ac-
 cu rate ly when passed to another application or displayed in 
the mon i tor.  Be cause the color profi les required for a cal i -
brat ed RGB color space are not available when Nikon CMS is 
off, images can only be scanned as uncalibrated RGB or gray-
scale.  Similarly, the absence of a monitor profi le means that 
gamma adjustment must be used to correct the image for 
dis play on the monitor or for editing in another application.  
These ad just ments to gamma are made in the “Gamma” 
category of the “Pref er enc es” dialog.

The illustration below shows how scanning proceeds when 
Nikon CMS is off.  The image shown in the preview window 
is ad just ed for display in the monitor ac cord ing to the value 
cho sen for preview gamma in the “Gam ma” category.  When 
the Scan but ton is clicked, the main scan gamma and any 
changes to curves and color balance are passed to the scan-
 ner, where they are ap plied to scan data be fore the image is 
trans ferred to the host ap pli ca tion (if Nikon Scan is used as 
a “stand-alone” ap pli ca tion, the value for preview gam ma 
is passed to the scan ner instead of main scan gamma).  The 
LCH Editor and Unsharp Mask tools can not be used when 
Nikon CMS is off.
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Gamma
When the Use Nikon Color Management System option 
in the “Color Management” category (  84) is off, the con-
trols in the “Gamma” category are used to adjust data from 
the scanner so that they display correctly when previewed on 
the monitor or opened in an oth er application.

 Preview gamma
Preview gamma applies to the image displayed in the pre-
 view area of the scan window.  In general, preview gamma 
is solely for display in the preview area and does not apply 
to the image data that are passed to the host application 
when the Scan button is clicked.  There are two exceptions 
to this rule, how ev er.  The fi rst is when Nikon Scan is used as 
a “stand-alone” application, the second when Use preview 
gam ma is se lect ed as the main scan gamma option.  In 
these cases pre view gam ma is ap plied to im age data passed 
to the host ap pli ca tion.

Preview gam ma de faults to a val ue of 1.8 on the Macintosh, 
2.2 on Win dows com put ers.  To choose a set ting suited to 
the current monitor, adjust the value so that the pat terns of 
gray lines and dots above the slider match in density.  Gam-
 ma can be set by en ter ing a value directly into the text box or 
by moving the slider.  When mak ing this ad just ment, set the 
res o lu tion on the monitor to a low value such as 640 × 480 
and sit as far away from the monitor as possible.  To restore 
the default setting for your platform, click Reset.
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Main scan gamma
Main scan gamma options are only 
visible when Nikon Scan is being 
used as a TWAIN source or acquire 
plug-in for an oth er program (when 
Nikon Scan is used as a “stand-
alone” application, preview gamma automatically applies 
both to the preview image and to the fi nal scan).  Image data 
passed to the host application are modifi ed according to the 
option chosen here.  Three op tions are available:

Use preview gamma
The gamma value chosen for preview gamma is applied be-
 fore the data are passed to the host application.  Use this 
setting when the host application does not support in de -
pen dent gam ma settings and you want the fi nal image to be 
modifi ed for display on your monitor.

Use application gamma
In some environments, a value for gamma can be chosen 
in the host application and passed to the Nikon Scan plug-
in.  When Use application gamma is selected, this value is 
applied to the main scan data before they are passed to the 
host application.

Two conditions must be fulfi lled if this option is to be ef fec -
tive.  First, the in ter face be tween the ap pli ca tion and Nikon 
Scan must allow the gamma value to be passed to the Nikon 
Scan plug-in.  The TWAIN in ter face used under Windows 
does not, however, allow the gamma value to be passed to 
the TWAIN source (i.e., to Nikon Scan).  Con se quent ly, in the 
Windows ver sion of Nikon Scan a default val ue of 2.2 is used 
for main scan gamma when ev er Use ap pli ca tion gam ma 
is se lect ed.  Second, the ap pli ca tion must sup port gamma 
transfer.  If Use ap pli ca tion gam ma is se lect ed with a 
Macintosh ap pli ca tion that does not sup port this fea ture, 
Macintosh system gamma (1.8) will be used.

Use custom gamma
When this option is selected, a value for main scan gam ma 
can be en tered in the text box.
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Color Management
The profi les used by the Nikon Color Management System 
are specifi ed in the “Color Man age ment” category.

Use Nikon Color Management System
This option turns the Nikon Color Management System on 
and off.  Changes to this setting only take effect after Nikon 
Scan has been quit and restarted.

When Nikon CMS Is On…
…images are processed to ensure consistent color re pro -
duc tion, as described in “How Nikon CMS Works” (  79).  
Because color management profi les typically contain their 
own settings for gamma, the controls in the Gamma tab are 
dimmed and inactive.

When Nikon CMS Is Off…
…monitor and color-space profi les are not used, and the 
con trols in the Color Management tab are dimmed and in-
 ac tive.  The only tool available for ensuring that colors from 
the scan ner will be displayed accurately on the monitor is 
the “Gamma” category (  82).  The only adjustments made 
to the image be fore it is passed to the host application are 
gam ma ad just ment and changes to curves and color balance 
made in the scan win dow.
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The “Monitor” Tab
The “Monitor” tab specifi es the profi le that will be used 
when images are displayed on your monitor, either in the 
scan window preview area or a Nikon Scan image window.  
Monitor profi les contain information about the color and 
gam ma characteristics of the monitor, allowing images to be 
ad just ed for more accurate color reproduction.

Use factory default monitor profi le (default)
Nikon Scan is supplied with default monitor profi les for use 
when no other profi le is available (see below).  To use the 
default pro fi le for your plat form, select Use factory default 
mon i tor pro fi le.

Default Windows Monitor Profi le (Gamma 2.2)
The default Windows monitor profi le (“NkMonitor_Win.icm”) 
is identical to the sRGB profi le.

Default Macintosh Monitor Profi le (Gamma 1.8)
The default Macintosh monitor profi le (“NkMonitor_
Mac.icm”) is iden ti cal to the profi le used for Apple 17˝ moni-
tors with a D50 white point.

Use custom monitor profi le
Use this option to select a profi le supplied by the company 
that manufactured the monitor.  When this option is se-
 lect ed, the Choose Custom Profi le… button will be ac tive.  
Click ing this but ton dis plays a standard “open fi le” di a log; 
nav i gate to the disk and folder containing the man u fac tur er’s 
pro fi le.  The path to the selected profi le will appear in the 
text box below the Use custom mon i tor profi le radio but-
 ton.
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The “RGB” Tab
The “RGB” tab is used to select a color-space profi le for the 
cal i brat ed RGB color model.  The profi le used can be se lect ed 
from the Color space menu.

Each of the pro fi les listed may be classifi ed according to its 
gam ma value and gamut.  Gamma is a fundamental char-
 ac ter is tic of im ag ing systems which determines the intensity 
of the output sig nal relative to the input; in human terms, 
gamma controls the subjective brightness of images through 
al ter ations to the out put level for mid-tones.  Win dows 
and Macintosh systems pro cess video signals dif fer ent ly, 
and these differences are re fl ect ed in the difference in the 
standard gam ma values for these plat forms.  The default 
system gamma for Macintosh computers is 1.8, the de facto 
standard for Win dows systems, 2.2.  Nikon CMS includes 
eight RGB pro fi les with a Windows gamma of 2.2 (sRGB, 
Bruce RGB, NTSC [1953], Adobe RGB [1988], CIE RGB, Wide 
Gamut RGB, compensated Wide Gamut RGB, and Scanner 
RGB), and three profi les with a gam ma val ue of 1.8 (Apple 
RGB, ColorMatch RGB, and compensated Apple RGB), for 
use on the Macintosh.  When scan ning im ag es, choose a 
profi le with a gam ma value suited to the sys tem on which 
the image will be edited.



87TOPPreferences— Nikon Color Management

The “CMYK” Tab
The CMYK sheet is used to select a profi le for use with the 
CMYK color model.

Use factory default  CMYK profi le (default)
Nikon Scan is supplied with a default CMYK profi le (the 
SWOP color library) for use when no other profi le is avail-
 able.  This profi le is used when Use factory default CMYK 
profi le is se lect ed.

Use custom profi le
Use this option to select a profi le supplied by the company 
that manufactured your printer.  When this option is se lect ed, 
the Choose Custom Profi le… button will be active.  Click-
 ing this but ton displays a standard open-fi le dialog; nav i gate 
to the disk and folder con tain ing the man u fac tur er’s pro fi le.  
The path to the se lect ed profi le will appear in the text box 
below the Use custom CMYK profi le ra dio but ton.

  CMYKCMYK
Images can not be scanned in CMYK.  If CMYK data are required, con-
vert images to CMYK before saving them to disk.  Note that images 
can only be saved in CMYK if Nikon CMS is on (Nikon CMS is on by 
default).
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RGB Profi les Provided with Nikon Scan

Windows Profi les (Gamma 2.2)
sRGB
This RGB profi le is used in the majority of Windows mon-
 i tors.  It closely re sem bles the RGB commonly used in color 
tele vi sion, and is also used in the digital tele vi sion broad-
casting sys tem that is on its way to becoming the industry 
standard in the United States of Amer i ca.  Soft ware and 
hardware man u fac tur ers use it as a default color profi le and 
guarantee operation when it used.  It is also on its way to 
be com ing the standard for images on the web.  This profi le 
is suited to users who plan to use their digital images “as is,” 
without editing or printing them.  It however suffers from 
the draw back of a narrow gamut with a limited area avail-
able for re pro duc ing blues.  The cor re spond ing RGB setting 
in Photoshop 5.0 is “sRGB.”

Bruce RGB
This color profi le attempts to expand on the ColorMatch 
RGB gamut by de fi n ing the chromaticity for G as lying be-
tween the values for G in the Adobe RGB and ColorMatch 
color-space pro fi les.  It was pro posed by Bruce Fraser, who 
claims that it in cludes most of the colors in the SWOP CMYK 
gamut.  It is not provided in the standard install of Photoshop 
5.0, but can be selected as the RGB color-space profi le for 
Photoshop by im port ing the profi le “NkBruce.icm”.

NTSC (1953)
This is the color space for video defi ned by the National 
Tele vi sion Standards Committee (NTSC) in 1953 and used in 
early color televisions.  This color space is also used in some 
Far-East newspaper and printing organizations.  The cor re -
spond ing RGB set ting in Photoshop 5.0 is “NTSC (1953).”

Adobe RGB (1988)
A color-space profi le defi ned in Photoshop 5.0.  It has a 
wider gamut than sRGB and includes the colors found in 
most CMYK gam uts, making it suitable for users involved in 
desktop pub lish ing.  The corresponding RGB setting in Pho-
toshop 5.0 is “Ado be RGB (1988).”

CIE RGB
A video color-space profi le established by the CIE.  While 
it boasts a fairly wide gamut, it suffers from the drawback 
that the area de vot ed to the re pro duc tion of cyan is relatively 
small.  The cor re spond ing RGB setting in Photoshop 5.0 is 
“CIE RGB.”

Wide Gamut RGB
This color-space profi le, designed by Adobe, in cor po rates 
most of the visible colors.  This however has the con se quence 
that most of the colors it can express can not be reproduced 
on standard mon i tors and print ers.  The corresponding RGB 
set ting in Photoshop 5.0 is “Wide Gamut RGB.”
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Wide Gamut RGB (compensated)
Nikon scanners can scan some colors that cannot be ex-
 pressed using the Wide Gamut RGB color-space profi le.  
The com pen sat ed Wide Gamut RGB profi le redefi nes Wide 
Gamut RGB to include all the colors that can be output from 
the scanner.  Be cause many of the colors that can not be ex-
pressed in Wide Gamut RGB occur in the blue por tion of the 
gamut, the level of detail in the blue area has been greatly 
increased (be cause the gamut has been expanded in a non-
 lin ear fash ion to in cor po rate just those colors that could not 
otherwise be ex pressed, it can not be rep re sent ed in chro-
 ma tic i ty di a grams using a stan dard RGB triangle).  As is the 
case with Wide Gam ut RGB, most of the colors defi ned in 
this profi le can not be re pro duced on mon i tors and print-
ers.  It is output to the host ap pli ca tion as Wide Gamut RGB.  
When scanning images into Photoshop 5.0 using this profi le, 
set the Photoshop RGB profi le to “Wide Gamut RGB.”

Scanner RGB
This profi le replicates the color space achieved when scan ning 
with Nikon CMS off.  Its main purpose is to allow the LCH 
ed i tor and Unsharp Mask tools, which are not available when 
Nikon CMS is off, to be used to edit the colors produced by 
the scan ner.  In order to pro duce the effect achieved by turn-
ing Nikon CMS off, the mon i tor profi le is not used, nor is an 
ICC profi le included with the image when it is opened in the 
host ap pli ca tion.
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Macintosh Profi les (Gamma 1.8)
Apple RGB
This profi le is used in desk-top publishing applications and 
in Adobe Photoshop ver sions 4.0 or earlier, and is the typical 
RGB profi le for Macintosh monitors.  The corresponding RGB 
set ting in Photoshop 5.0 is “Apple RGB.”  This profi le is suit-
 able for work ing with images dis played on the Macintosh.

ColorMatch RGB
The ColorMatch profi le is native to Radius PressView mon-
 i tors.  It has a wider gamut than Apple RGB, with a par tic u-
 lar ly wide area devoted to the reproduction of blues.  The 
cor re spond ing RGB setting in Photoshop 5.0 is “Color Match 
RGB.”

Apple RGB (compensated)
This profi le defi nes tristimulus (red, green, and blue) chro ma -
tic i ty as the intersection of the curve that marks the limits of 
the visible gamut with lines drawn from the Apple RGB white 
point and pass ing through the points that defi ne tri stimulus 
chro ma tic i ty in the Apple RGB color-space profi le.  This pro-
fi le is unique in that it preserves the characteristics of Apple 
RGB while al low ing more sat u rat ed colors.  It is not pro vid ed 
in the stan dard install of Photoshop 5.0, but can be selected 
as the RGB color-space profi le for Photoshop by im port ing 
the profi le “NKApple_CPS.icm”.
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“Gamut”
In addition to gamma, profi les can be classifi ed according to 
their gamut, or the range of colors that can be ex pressed us-
ing the profi le.  Gamut is conventionally expressed by means 
of chromaticity, a measure of color developed by the Com-
mission Internationale de l’Éclairage (CIE).  The CIE system, 
which is modeled on hu man color perception, maps the 
physical wave lengths of light to three coordinates (known 
as CIE X, Y, and Z) that give unique nu mer i cal ex pres sion 
to the full range of color differences that can be per ceived 
by hu mans.  Chro ma tic i ty is a mea sure of col or from which 
con sid er ations of bright ness have been fac tored out, giving 
a two-co or di nate system.

In the chromaticity diagram at right, the complete gamut of 
col ors visible to hu mans is in the area en closed by the green 
line.  The curved portion of the line gives the chro ma tic i ty 
of “pure,” un mixed colors with wavelengths in the visible 
spec trum of 380–780 nm.  The blue end of the spectrum 
(380 nm) is at the bot tom left corner, the red end of the 
spectrum (780 nm) at the bot tom right corner.  The straight 
diagonal line con nect ing these two points rep re sents the dif-
 fer ent shades of purple cre at ed by combining red and blue 
light.  The colors inside the area en closed by these lines are 
created by mixing light of dif fer ent wave lengths.

No color profi le is capable of expressing the full range of col-
ors visible to the human eye.  The diagram below com pares 
the gam ut of col ors vis i ble to the eye with the colors that can 
be ex pressed in each of the RGB profi les pro vid ed with Nikon 
CMS.  The gamut for each profi le is con tained in the triangle 
defi ned by the three points that mark the ex tremes of red, 
green, and blue for that profi le (red is at the bot tom right 
corner, green at the top of the triangle, and blue at the bot-
tom left corner).  The white point for each profi le is shown 
by the symbol in the cen ter of the triangle.
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The following table shows the gamma values for the profi les included with Nikon CMS, together with the chro ma tic i ty val-
ues for the white point and for red, green, and blue.
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  Keeping Colors True in Other ApplicationsKeeping Colors True in Other Applications
When an image is scanned in the Nikon Scan TWAIN source or ac quire 
plug-in and opened in another application, or when an image saved 
using Nikon Scan is opened in another application, the image will be 
pro cessed ac cord ing to the col or-space and monitor profi les se lect ed in 
the application before being displayed on the monitor.  If the pro fi les 
used in the ap pli ca tion do not match those used in Nikon Scan, col ors 
may not be the same as those in the original image.

RGB Color Model
Choose a monitor pro fi le that match es that cho sen in the “Monitor” 
tab and a color-space pro fi le that match es that se lect ed in the “RGB” 
tab (the Photoshop pro fi les cor re spond ing to those used in Nikon Scan 
are list ed on the preceding pag es).  If no match ing RGB profi le exists, 
you can use the Nikon Scan profi les in the path Pro gram Files\Common 
Files\Nikon\Profi les (Win dows) or Sys tem Folder : Pref er enc es : Nikon 
MAID : Profi les (Macintosh).  The fi les containing the profi les listed in 
the RGB sheet are given below.

Profi le File name

sRGB NKsRGB.icm

Bruce RGB NKBruce.icm

NTSC (1953) NKNTSC.icm

Adobe RGB (1998) NKAdobe.icm

CIE RGB NKCIE.icm

Wide Gamut RGB NKWide.icm

Apple RGB NKApple.icm

Color Match RGB NKMatch.icm

Apple RGB (compensated) NKApple_CPS.icm

* Do not use the “Scanner RGB” profi le when scanning images for use 
in a third-party application.

When Nikon Scan is used as an acquire plug-in to the Macintosh version 
of Adobe Photoshop 5 or later (full ver sion), the RGB profi le will auto-
matically be passed to Photoshop when the image is scanned.  Be sure 
that the monitor profi le matches that used in Photoshop by selecting the 
Photoshop monitor profi le in the monitor sheet of the Nikon Scan color 
management tab.

CMYK Color Model
Choose a monitor pro fi le that match es that cho sen in the monitor sheet 
and a color-space pro fi le that match es that se lect ed in the CMYK sheet.  
When Nikon Scan is used as an acquire plug-in to the Macintosh ver-
sion of Adobe Photoshop 5 or later (full ver sion), the CMYK profi le will 
automatically be passed to Photoshop when the image is scanned.
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Macintosh
The volume used for temporary storage can be chosen from 
the Scratch disk menu.  The amount of space avail able on 
the selected disk is shown under the menu.

File Locations/Scratch DisksFile Locations/Scratch Disks
Choosing a Location for Temporary StorageChoosing a Location for Temporary Storage

The “File Locations” (Windows) or “Scratch Disks” (Macin-
tosh) category is used to choose the folder or volume (disk) 
that will be used for tem po rary stor age, or “vir tu al mem o ry,” 
while Nikon Scan is in op er a tion.  It is rec om mend ed that 
only disks with a high data trans fer rate, such as hard disks, 
be selected for tem po rary stor age.

Windows
The folder currently selected for temporary storage is shown 
under Folder for Temporary Data.  To choose a different 
location, click Change Location… and nav i gate to the de-
sired drive and folder.

  Changes to “File Locations”/”Scratch Disks” SettingsChanges to “File Locations”/”Scratch Disks” Settings
Changes to “File Locations” and “Scratch Disks” settings only take ef-
 fect af ter you have quit and restarted Nikon Scan.
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Single ScanSingle Scan
Scan Settings for Single ScansScan Settings for Single Scans

The “Single Scan” category is used to specify the tasks per-
formed au to mat i cal ly before and after single scans.

Before scan

Option Description

Auto  ex po sure 
for negative 

fi lm

If this item is checked (the default set ting), an auto-
exposure operation will be per formed as necessary 
before scanning fi lm negatives.

Auto  ex po sure 
for pos i tive 

fi lm

If this item is checked (the default set ting), an auto-
exposure operation will be per formed as necessary 
before scanning fi lm pos i tives.

Auto focus

If this item is checked (the default set ting), an auto-
focus operation will be per formed as necessary be-
fore making a scan.   “Before Scan”“Before Scan”

If Perform auto focus when fi lm is inserted is selected in the 
“Scanner Extras” palette, an autofocus operation will au to mat i cal ly be 
per formed when a slide is inserted in a slide-mount adapter (5000 ED, 
4000 ED, COOLSCAN V ED, COOLSCAN IV ED) or when a holder other 
than the FH-869S or FH-869G is inserted in the 9000 ED or 8000 ED.  
As a result, an autofocus operation will not au to mat i cal ly be performed 
before the image is scanned, even if Auto focus is selected for “Before 
scan.”  In the case of the 9000 ED and 8000 ED, this applies only to the 
fi rst frame in the holder; an autofocus operation will automatically be 
performed prior to scanning for all subsequent frames.

After scan

Option Description

Close
window 
and eject 

fi lm

When this item is checked, the scan window automatical-
ly closes after scanning.  Holders are automatically eject-
ed from the 9000 ED/8000 ED, and fi lm is automatically 
eject ed from the SA-21, IA-20 (S), SA-30 (5000 ED/4000 
ED), and SF-210/SF-200 (S) (5000 ED/4000 ED).  The de-
 fault setting is off.

Save to 
disk

If this item is checked when Nikon Scan is used as a stand-
alone application, the im age created when the Scan but-
ton is clicked will be saved to disk instead of being opened 
in an image window.  When the Scan button is clicked, a 
“Save” di a log will ap pear; spec i fy a name, lo ca tion, and 
fi le type for the image.  This op tion has no effect when 
Nikon Scan is be ing used as a plug-in or TWAIN source for 
another ap pli ca tion.  The de fault setting is off.
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Batch ScanBatch Scan
Scan Settings for Batch ScansScan Settings for Batch Scans

The “Batch Scan” category is used to specify the tasks per-
formed au to mat i cal ly before, during, and after batch scans.

Before batch scan

Option Description

Create scan 
log

If this item is checked (the default setting), a log show-
ing the operations performed and errors that occurred 
during the batch scan will be displayed in the “Log” 
tab of the progress window.  If Save to disk is select-
ed for “After each image”, the log will be saved to the 
same folder as the scanned images.

Prompt
for this

information

If this item is checked (the default setting), a dialog con-
taining the same options as appear in the “Batch Scan” 
category will be dis played at the start of a batch scan.

Before each image

Option Description

Auto  ex po sure 
for negative 

fi lm

If this item is checked (the default set ting), an auto-
exposure operation will be per formed as necessary 
before scanning fi lm negatives.

Auto  ex po sure 
for pos i tive 

fi lm

If this item is checked (the default set ting), an auto-
exposure operation will be per formed as necessary 
before scanning fi lm pos i tives.

Auto focus

If this item is checked (the default set ting), an auto-
focus operation will be per formed as necessary be-
fore each scan.

  “Before Each Image”“Before Each Image”
If Perform auto focus when fi lm is inserted is selected in the 
“Scanner Extras” palette, an autofocus operation will au to mat i cal ly be 
per formed when a slide is inserted in a slide-mount adapter (5000 ED, 
4000 ED, COOLSCAN V ED, COOLSCAN IV ED) or when a holder other 
than the FH-869S or FH-869G is inserted in the 9000 ED or 8000 ED.  
As a result, an autofocus operation will not au to mat i cal ly be performed 
before the image is scanned, even if Auto focus is selected for “Before 
each image.”  In the case of the 9000 ED and 8000 ED, this applies only 
to the fi rst frame in the holder; an autofocus operation will automati-
cally be performed prior to scanning for all subsequent frames.
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After each image

Option Description

Stop on
errors

If this item is checked (the default setting), scanning 
will stop when minor errors are encountered.  If it is not 
checked, scanning will only stop when all the selected im-
ages have been scanned, fi lm jams in the scanner, or a 
hardware error occurs.

Save to 
disk

If this item is checked (the default setting) when Nikon 
Scan is used as a “stand-alone” application, scanned im-
ages will be saved to disk in stead of being opened in im-
age windows.  When the Scan button is clicked, a dialog 
will appear where the user can specify a location and fi le 
type and choose how the fi les will be named.  This op tion 
has no effect when Nikon Scan is be ing used as a plug-in 
or TWAIN source for another ap pli ca tion.

After batch scan

Option Description

Close
window 
and eject 

fi lm

When this item is checked, the scan window automati-
cally closes after scanning.  Holders are automatically 
ejected from the 9000 ED/8000 ED, and fi lm is automati-
cally eject ed from the SA-21, IA-20 (S), SA-30 (5000 ED/
4000 ED), and SF-210/SF-200 (S) (5000 ED/4000 ED). 
 The de fault setting is off.

The “File Saving Options” Dialog
If Save to disk is selected in the “Batch Scan” category 
when Nikon Scan is used as a stand-alone application, a 
“File Saving Options” dialog will ap pear at the start of a 
batch scan.
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The “File Saving Options” dialog contains the following:

File Naming
Files saved during a batch scan are assigned names con sist ing 
of a prefi x, a fi le number of from one to six digits assigned 
in as cend ing or der from a user-specifi ed starting point, and 
a suffi x.  The options in the “File Naming” area control the 
prefi x, fi le num ber, and suffi x.

Option Description

Number 
of Digits Specify the number of digits in the fi le number.

Suffi x Enter a suffi x of up to 65 characters.

Prefi x Enter a prefi x of up to 65 characters.

Starting
Index

File numbers are assigned in ascending order starting from 
this number.

Sample Shows a sample of the fi le names that will be assigned.

File Saving

Option Description

Compression 
Level

If the selected fi le format supports compression, the 
amount of compression can be selected from this 
menu.

File Format
Select a format from NEF, TIFF, TIFF (CMYK), JPEG, 
BMP (Windows only), and PICT (Macintosh only).

…
To choose a destination folder for the images, click 
this button and navigate to the desired folder.

  File-Naming ConventionsFile-Naming Conventions

Windows
Where long fi le names are supported, the maximum length is 255 
characters.  File names may not contain quotes or any of the following 
characters: “\\” “/” “:” “,” “;” “*” “<“ “>” and “|”.

In environments that do not support long fi le names, the maxi-
mum length is eight characters; fi le names may not contain spaces, 
quotes, or any of the following characters: “\\” “/” “:” “,” “;” “*” “?” 
“<“ “>” and “|”.

Macintosh
The maximum length for Macintosh fi le names is thir ty-one characters.  
Colons (“:”) are not allowed.
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File SavingFile Saving
Choosing a Default File Format and CreatorChoosing a Default File Format and Creator

The “File Saving” category is used to choose the default 
fi le type for images saved when Nikon Scan is used as a 
“stand-alone” ap pli ca tion.  The Macintosh version also has 
an option for choosing the “creator” application, i.e., the ap-
plication that will start when fi les saved from Nikon Scan are 
double-clicked.

Windows

Option Description

Use alternate 
creator code

(Macintosh 
only)

If this option is selected, a new creator application 
can be chosen by clicking the Choose Applica-
tion… but ton and navigating to the desired ap pli -
ca tion.  This option is not avail able in the Windows 
version of Nikon Scan.

Compression 
level 

If the selected fi le format supports compression, the 
amount of compression can be selected from this 
menu.

Default fi le 
format

Select the default fi le format from NEF, TIFF, TIFF 
(CMYK), JPEG, BMP (Windows only), and PICT (Ma-
cintosh only).  Select Last used to choose the for-
 mat most re cent ly used to save im ag es when Nikon 
Scan was used as a “stand-alone” ap pli ca tion.

Macintosh
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Automatic ActionsAutomatic Actions
Preview Area OptionsPreview Area Options

The “Automatic Actions” category controls the actions per-
formed when media are inserted in the scanner or the focus 
point is adjusted using the focus tool in the “Layout Tools” 
palette.

Option Description

Perform auto 
focus when 

focus point is 
moved

If this option is select, the scanner will automatical-
ly perform an autofocus op er a tion when the focus 
point is changed us ing the focus tool in the “Layout 
Tools” pal ette.  If it is not checked, autofocus will 
only be per formed when the  but ton is clicked in 
the scan window control area.

Thumbnail 
when fi lm is 

inserted

If Ten or fewer thumbnails is selected, the scan-
 ner will au to mat i cal ly generate thumbnails when APS 
or strip fi lm with ten or fewer frames is inserted in a 
multi-frame adapter.  If More than ten thumb nails 
is checked, the scan ner will au to mat i cal ly generate 
thumbnails when fi lm is inserted in the SA-30 or IA-
20 (S).  This option is not available when the 9000 ED 
or 8000 ED is connected.

Preview
when fi lm is 

inserted

If Single image adaptor is selected, the scan ner 
will au to mat i cal ly perform a pre view when a slide is 
inserted in the MA-21/MA-20 (S) slide-mount adapt-
er or the op tion al SF-210/SF-200 (S) slide feeder.  If 
Multiple image adap tor is checked, the scanner 
will au to mat i cal ly perform a preview using user de-
fault set tings when fi lm is inserted in a multi-frame 
adapter (if no user de faults are de fi ned, fac to ry de-
faults will be used).  This option is not available when 
the 9000 ED or 8000 ED is connected.
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Advanced ColorAdvanced Color
White Point, Gray Point, Black Point, and Auto ContrastWhite Point, Gray Point, Black Point, and Auto Contrast

The “Advanced Color” category is used to specify output 
col ors for the black, white, and gray points and to change 
the size of the area sampled when the eyedropper tools in 
the “Curves” palette are used.  It is also controls the portion 
of the tone range excluded in auto contrast operations.

White-, Gray-, and Black-Point Targets
The targets in the “RGB” and “Grayscale” tabs specify de-
 fault out put values for the white, gray, and black points in 
each color model.  The fac to ry default set ting for white point 
is 255 for each channel, which displays as white on most 
com put er mon i tors.  The factory default for the gray point 
is 128, which displays as a neutral gray.  The de fault for the 
black point is zero, which dis plays as black.  To restore fac-
tory de faults for the color mod el in the selected sheet, click 
Reset.

  The Master ChannelThe Master Channel
To set the white and black points for the master channel in the RGB 
color model, select RGB in the “Curves” palette channel menu, click the 
white- or black-point eyedropper tool while pressing Ctrl (Windows) or 
option (Macintosh), and sample the image.

  Output ValuesOutput Values
Although output values in the “Advanced Color” palette range from 
zero to 255, cal cu la tions are per formed at a pre ci sion of six teen bits.
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Sample Point Size
This setting determines the size of the area sampled for the 
color-value display and the white-point, gray-point, and 
black-point tools.  Sample point size can be set to 1 × 1, 3 × 3, 
or 5 × 5 pixels.  When the sample size is set to 3 × 3 or 5 × 5, 
Nikon Scan averages the pixels sampled.  Choosing a large 
sample size reduces pre ci sion, but also minimizes the effects 
of noise; choosing a small sample size has the opposite ef-
fects.

  Digital DEEDigital DEE
When inspecting color values to determine the threshold for Digital 
DEE, set the sample point size to 5 × 5 pixels.  Note that color values 
are displayed in the “Information” palette and information panel when 
an eyedropper tool is selected; be careful not to click the image when 
determining the threshold for Digital DEE.  If an eyedropper cursor is 
selected, clicking the image could reshape the active curve.

Auto Contrast Calculations
The Auto contrast calculations option controls how 
auto contrast operations in the “Curves” and “LCH Editor” 
pal ettes calculate the input val ues for the white point and 
black point.  By default, the white point is set to a value that 
excludes 0.5% of the bright est pixels in the current crop, 
the black point to a value that ex cludes 0.5% of the dark est 
pixels in the crop.  This produces an optimal dy nam ic range, 
with min i mum loss of de tail in shad ows and high lights.  To 
pre serve detail at the ex pense of dy nam ic range, low er the 
“ex clud ed” value for auto contrast (a value of zero will set 
the black and white point re spec tive ly to the dark est and 
bright est pixel in the crop).  To increase the dynamic range at 
the ex pense of detail, raise the “excluded” value.
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Preview SettingsPreview Settings
Automating PreviewsAutomating Previews

The “Preview Settings” category determines the operations performed automatically when the Preview button is clicked.
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Option

Auto 
ex po sure for
negative fi lm

If this item is checked (the default set ting), an autoex-
posure operation will be per formed as necessary be-
fore previewing fi lm negatives.

Auto 
ex po sure for
pos i tive fi lm

If this item is checked (the default set ting), an autoex-
posure operation will be per formed as necessary be-
fore previewing fi lm pos i tives.

Auto focus

If this item is checked (the default set ting), an auto-
focus operation will be per formed as necessary when 
the Preview button is clicked.

Multi
sampling

Check this item to perform multi-sample scanning 
during preview (9000 ED, 8000 ED, 5000 ED, 4000 
ED only).  Multi-sample scanning will not be per-
formed if Normal (1×) is selected in the “Scanner Ex-
tras” palette.  Selecting this option increases the time 
needed to complete a preview, while the effects of 
multi-sample scanning may not be visible in the pre-
view area at the normal zoom ratio.

Digital ICE

If this item is checked (the default option), the image 
will be processed during preview to reduce the effects 
of dust and scratches.  This option only takes effect if 
Enable Digital ICE is selected in the “Digital ICE4 Ad-
vanced” palette.  Selecting this option increases the 
time needed to complete a preview.

  Autofocus/AutoexposureAutofocus/Autoexposure
If an autofocus or autoexposure operation has already been performed 
on the current frame, it will not automatically be repeated before a 
preview or scan.  The autofocus and autoexposure buttons in the scan 
window can be used to perform these operations manually if desired.  If 
Perform auto focus when fi lm is inserted is selected in the “Scanner 
Extras” palette, an autofocus operation will au to mat i cal ly be per formed 
when a slide is inserted in a slide-mount adapter (5000 ED, 4000 ED, 
COOLSCAN V ED, COOLSCAN IV ED) or when a holder other than the 
FH-869S or FH-869G is inserted in the 9000 ED or 8000 ED.  As a re-
sult, an autofocus operation will not au to mat i cal ly be performed before 
the image is scanned, even if Auto focus is selected in the “Preview 
Settings” category.  In the case of the 9000 ED and 8000 ED, this ap-
plies only to the fi rst frame in the holder; an autofocus operation will au-
tomatically be performed prior to scanning for all subsequent frames.

Description

Cache
preview

image for 
single image 

adapter

If this item is checked (the default option), Nikon Scan 
will store the last preview created with the MA-21/
MA-20 (S) slide-mount adapter.  This preview will be 
displayed the next time the scan window is opened or 
the MA-21/MA-20 (S) is inserted.
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Grid SettingsGrid Settings
Creating a Layout GridCreating a Layout Grid

The “Grid Settings” category determines the color and spac-
ing of the grid displayed over the image in the active window 
when Show grid is selected in the “Layout Tools” palette.

Option

Display n 
subdivisions 

per line

Enter the number of subdivisions into which each grid 
cell will be divided.  The main grid appears as solid 
lines, the subdivisions as broken lines.

Display grid 
line every

Enter the spacing for the layout grid.  Units can be se-
lected from the menu to the right of the text box.

Color Choose the grid color.

Show grid 
for new

windows

If this item is selected, a layout grid will automati-
cally be displayed in the preview area.  If Nikon Scan 
is used as a “stand-alone” application, a layout grid 
will also be displayed on images newly opened in im-
age windows.

Description
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  Third-Party ApplicationsThird-Party Applications
When Nikon Scan serves as a TWAIN source or acquire plug-in for a third-party imaging application such as Adobe Photoshop, images will be 
opened in the third-party application after scanning.  See the documentation provided with the application for information on the operations that 
can be performed.

Image Windows
Using Nikon Scan as a “Stand-Alone” Application

This chapter describes the operations that can be performed in image windows when Nikon Scan is used as a “stand-alone” 
application.  Click the links for more information.

Windows Macintosh The Nikon Scan Applet (  107)

Rotating and Flipping Images (  112)

Saving Images (  109)

Image Windows (  108)

The Settings Section (  111)

Zoom (  112)

Color Space (  113)

Printing Images (  113)

Editing Images (  114)

The Toolbar (  115)

The Status Bar (Windows Only) (  117)

Menu Commands (  118)

Menu bar Toolbar

Status bar

Image window
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Click OK to close the message.  To open a previously-saved 
image for viewing, printing, or editing, select Open… from 
the Nikon Scan File menu.

Windows

The Nikon Scan AppletThe Nikon Scan Applet
Getting StartedGetting Started

When Nikon Scan is used as a “stand-alone” application, 
images can be saved, viewed, and printed in image windows 
opened in the Nikon Scan applet.  The Tool Chest can also be 
used to perform simple imaging tasks.

When Nikon Scan is used as a TWAIN source or acquire 
plug-in for a third-party imaging application such as Adobe 
Photoshop, images will not be opened in the Nikon Scan ap-
plet after scanning.  Instead, they will be opened in the third-
party application, where they can be viewed, edited, printed, 
and saved according to the options available.

Starting the Nikon Scan Applet
For information on starting the Nikon Scan applet, see 
“Starting Nikon Scan as a ‘Stand-Alone’ Application” (  9).  
If no scanner is connected, the following message will be 
displayed when Nikon Scan is started:

  Opening Images from the Toolbar (Windows Only)Opening Images from the Toolbar (Windows Only)
Image fi les can also be opened by clicking the  button in the toolbar 
(Windows only).

Macintosh
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Image WindowsImage Windows
Viewing ImagesViewing Images

When Nikon Scan is used as a “stand-alone” application, 
images are opened in image windows after scanning (except 
when Save to disk is selected in the “Preferences” dialog; 

 77) or when a fi le is selected using the Open… option in 
the File menu.

  Layout GridLayout Grid
If Show grid is selected in the “Layout Tools” palette, a layout grid will 
be displayed over the image in the active window.  The grid can also be 
displayed by selecting Show Grid from the View menu.

  Selecting the Active WindowSelecting the Active Window
When multiple windows are open in the Nikon Scan applet, a window 
can be activated and brought to the front by clicking the window or 
by choosing it from the windows listed at the bot tom of the Win dow 
menu.

  The Tool ChestThe Tool Chest
Many of the tools in the Tool Chest can be applied to images in im age 
windows.  If multiple images are opened in image win dows in the Nikon 
Scan applet, settings can be adjusted and saved separately for each im-
age.  With the exception of images saved in NEF format, the settings 
in each tool palette will be reset to default values when an image is 
opened.  When an im age saved in NEF format is opened, the settings 
in each tool palette will be reset to the values in effect when the image 
was saved.

MacintoshWindows
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Saving ImagesSaving Images
Supported File FormatsSupported File Formats

To save the image in the active window under a new name, 
choose Save As… from the File menu.  A “Save As” dialog 
will be displayed; after navigating to the desired location, 
enter a fi le name and choose a fi le type.  Click Save to save 
the image.

Choosing a File Type
Nikon Scan supports the following formats:

Format

NEF

Changes to settings in the Tool Chest are not directly ap-
plied to images saved in NEF (Nikon Electronic Image For-
mat).  Instead, information about settings is saved separate-
ly in the same fi le as the image.  When the image is opened 
again in Nikon Scan, these settings will be loaded into the 
Tool Chest and applied to the image.  This allows settings to 
be adjusted without affecting the original image (the “origi-
nal image” is the image acquired from the scanner, modi-
fi ed according to the settings in effect in the scan window 
at the time image was scanned).  Note that Nikon Capture 
does not support NEF images created in Nikon Scan.  

Description

Format Description

TIFF

Use TIFF when saving images for high-quality output or 
editing.  Images scanned at a bit depth of twelve or more 
(twelve, fourteen, or sixteen bits) will be saved as sixteen-
bit TIFF, images scanned at a bit-depth of eight bits as 
eight-bit TIFF.  Al though the lack of com pres sion will re sult 
in larger fi les, a high level of im age qual i ty will be main-
 tained.  TIFF is sup port ed in a wide variety of ap pli ca tions 
on both Windows and Macintosh platforms.

JPEG

JPEG is a good choice for images that will be out put at low 
resolution or distributed in elec tron ic form.  Im ag es can be 
compressed, al low ing more im ag es to be saved in the same 
amount of disk space.  Note, however, that JPEG com pres sion 
results in loss of information that can not af ter wards be re-
 stored.  This format is not available when saving CMYK im-
 ag es or images with a bit depth of sixteen bits per channel.

TIFF 
(CMYK)

As above, except that the image is converted to the CMYK 
color model when saved.  This option is available only 
when Nikon CMS is on (Nikon CMS is on by default).

BMP
(Windows 

only)

Most Win dows users will be able to view fi les of this type.  
This format is not avail able in the Macintosh version of 
Nikon Scan, and does not support CMYK, six teen-bit gray-
scale, or six teen-bit RGB.

PICT
(Macintosh 

only)

PICT can be viewed on most Macintosh computers, and 
supports JPEG compression.  This format is not avail able in 
the Windows version of Nikon Scan, and does not support 
CMYK, six teen-bit grayscale, or sixteen-bit RGB.



110TOPImage Windows— Saving Images

  Choosing a Compression RatioChoosing a Compression Ratio
JPEG and PICT images can be compressed using JPEG com pres sion, in which images are divided into blocks eight pixels on a side and detail within 
each block selectively reduced.  Although raising the compression ratio decreases the fi le size, it also makes the block pattern more visible and may 
result in noticeable loss of detail (the actual effect depends on the output scale and the type of subject).  It is recommended that fi les be saved at 
the lowest com pres sion ratio possible; if nec es sary, they can always be opened and saved again at a higher com pres sion ratio.

The compression ratio can be chosen from a menu in the “Save As” dialog.  Five options are available, rang ing from Ex cel lent Quality, which of-
fers the lowest com pres sion and highest im age quality, to High Compression, which of fers the high est com pres sion and lowest image quality.
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The Settings SectionThe Settings Section
Viewing Image InformationViewing Image Information

To view information about the image in an image window, click the Settings Section triangle or select Settings Section 
from the View menu.

The settings section gives information about the time and date the image was created, the fi lm type, the scan bit depth, 
analog gain, Digital ICE4 Advanced, and multi-sample scanning.

Click to view image 
information

Windows

Image information hidden

Macintosh

Click to 
hide image 

information

Image
information

Image information displayed Image information displayed

Click to 
hide image 

information

Image
information
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Rotating and Flipping ImagesRotating and Flipping Images
Changing Image OrientationChanging Image Orientation

To fl ip or rotate the image in the active window:
• Use the fl ip or rotate buttons in the “Layout Tools” pal-

ette.

• Click the  (rotate clockwise) or  (rotate counterclock-
wise) buttons in the toolbar.

• Use the options in the Image > Transform sub-menu.

ZoomZoom
Zooming Images in and OutZooming Images in and Out

The active window can be zoomed in or out using the zoom 
cursor or the zoom options in the View menu.

The Zoom Cursor
To select the zoom cursor:
• click the  button in the “Layout Tools” palette,
• select Zoom Cursor from the View menu, or
• click the  button in the toolbar

Click anywhere within the image window to zoom in on the 
selected point.  To zoom out, click the image while pressing 
Alt (Windows) or option (Macintosh).

The View Menu
Open the View menu and select Zoom In to zoom in on the 
center of the image in the active window.  Select Zoom Out 
to zoom out.

To scroll the image, use the image window scroll bars or use 
the hand cursor to drag the image.  To view the entire image 
at the maximum possible zoom ratio, select Fit to Screen 
from the Window menu.  To view the image at a zoom ratio 
of 1 : 1, select Actual Size from the Window menu.

Rotate

Flip

“Layout Tools” palette
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Color SpaceColor Space
Selecting a New Color Model and Bit DepthSelecting a New Color Model and Bit Depth

To convert the image in the active window to a new color 
model and bit depth, select one of the following options 
from the Image > Color Space sub-menu.

Printing ImagesPrinting Images
Printing the Image in the Active WindowPrinting the Image in the Active Window

To print the image in the active window, select Print… from 
the File menu.  In the Windows version of Nikon Scan, im-
ages can also be printed by clicking the  button in the 
toolbar.

Option Description

16-bit 
Grayscale

Convert image to sixteen-bit grayscale capable of ex-
pressing 65,536 shades of gray.

8-bit 
Grayscale

Convert image to eight-bit grayscale capable of express-
ing 256 shades of gray.

24-bit 
RGB

Convert image to RGB at a bit depth of eight bits per 
channel (twenty-four bit RGB).

48-bit 
RGB

Convert image to RGB at a bit depth of sixteen bits per 
channel (forty-eight bit RGB).

  Converting Color Images to GrayscaleConverting Color Images to Grayscale
If a color image is converted to grayscale and then saved, the lost color 
information can not be restored.

  Print Preview (Windows Only)Print Preview (Windows Only)
To preview the image to be printed, select Print Preview… from the 
File menu (Windows only).
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  Tool Palette SettingsTool Palette Settings
The settings in effect in the scan window are applied to data from the scanner when the Scan button is clicked.  Any further changes to settings 
in image windows apply to these modifi ed image data.  To refl ect this, tool palette settings are restored to their default values when the images 
are opened in image windows.

Editing ImagesEditing Images
Editing Images After ScanningEditing Images After Scanning

The image in the active window can be edited using the following palettes in the Tool Chest:

Palette Operation

Information (  35) View information about the color of the point under the cursor and the size and location of the current selection.

Layout Tools (  33)
Flip, rotate, and scroll images, zoom images in or out, select an area to be copied to the clipboard, and display or 
hide the layout grid.

Curves (  41) Adjust contrast and color balance in selected portions of the tone range (shadows, mid-tones, or highlights).

Color Balance (  51) Adjust brightness, contrast, and color balance over the entire image.

LCH Editor (  56) Adjust brightness, color saturation, and hue.

Unsharp Mask (  53) Make edges more distinct, either over the entire image or in areas where a specifi c color predominates.
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The ToolbarThe Toolbar
Quick Command AccessQuick Command Access

The toolbar gives access to many commonly used commands 
with a single click.  The Windows and Macintosh versions of 
Nikon Scan have different toolbars.

Windows
To display or hide the toolbar, select Toolbar from the View 
menu.  When displayed, toolbar can be dragged out of the 
menu bar to a new position anywhere within the Nikon Scan 
application window, where it will “fl oat” in an independent 
window.

The toolbar contains the following buttons:

Button Description

Save the image in the active window.

Open an image in Nikon Scan.

Copy the current selection to the clipboard.

Print the image in the active window.
Print

Copy

Save

Open

Button Description

Select the zoom cursor to zoom images in and out.
Zoom Cursor

Choose the selection cursor to select an area in the 
active window.Selection Cursor

Open Nikon Scan help.
Help

Rotate the image in the active window clockwise.
Rotate 90° CW

Rotate the image in the active window counter-
clockwise.Rotate 90° CCW

Open the scan window.Open Twain 
source

Select the hand cursor to scroll images.
Hand Cursor
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Macintosh
In the Macintosh version of Nikon Scan, each image window 
has its own toolbar.

The toolbar contains the following buttons:

Button Description

Button Description

Shows the orientation of the image, refl ecting any 
fl ips or rotations.Image Orientation

Zoom the image in.
Zoom In

Zoom the image out.
Zoom Out

Rotate the image counterclockwise.
Rotate 90° CCW

Rotate the image clockwise.
Rotate 90° CW

Choose the selection cursor to select an area in 
the window.Selection Cursor

Select the zoom cursor to the zoom image in and 
out.Zoom Cursor

Select the hand cursor to scroll the image.
Hand Cursor

Display a dialog where selected Tool Chest set-
tings can be copied to the clipboard.Copy Settings

Paste settings copied with the  button into the 
Tool Chest for the current image.Paste settings
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The Status Bar (Windows Only)The Status Bar (Windows Only)
Tool TipsTool Tips

When the cursor is moved over a button or menu, a brief 
description of its function appears in the status bar at the 
bottom of the application window.

The status bar can be hidden or displayed by selecting Sta-
tus Bar from the View menu.

Status bar display for the “Save” button
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Menu CommandsMenu Commands
Index to Menu OptionsIndex to Menu Options

Windows

File

Open Twain Source
Open the scan window.

Open…
Open an image fi le.

Close
Close the active window.

Save
Save the image in the active win-
dow.

Save As…
Save the image in the active win-
dow under a new name.

Print…
Print the image in the active win-
dow.

Print Preview
Preview the image to be printed.

Print Setup…
Adjust printer settings.

Recent fi les
Recent fi les are listed in the order 
opened.  Choose a fi le to open it 
in an image window.

Exit
Exit Nikon Scan.

Edit

Undo
Undo the preceding operation.

Cut
The Ctrl-X shortcut can be used in 
dialogs to cut selected text to the 
clipboard.  The menu command 
itself can not be used.

Copy
The Ctrl-C shortcut can be used in 
dialogs to copy selected text to the 
clipboard.  The menu command it-
self can not be used.

Copy Settings…
Copy to the clipboard selected 
Tool Chest settings for the image 
in the active window.  A dialog will 
be displayed where the desired 
settings can be selected.

Copy All Settings
Copy to the clipboard all Tool 
Chest settings for the image in the 
active window.

Paste
Paste the contents of the clipboard 
to the Tool Chest.  The Ctrl-V 
shortcut can be used to paste text 
in a dialog.

Clear
Delete the contents of the current 
text box.

Preferences…
Display the “Preferences” dialog.
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Color Space

Convert the image in the active 
window to a new color space and 
bit depth.

Transform

Rotate or fl ip the image in the ac-
tive window.

Settings

Copy, save, load, delete, or reset 
settings for all tool palettes or for 
selected tool palettes.

Settings Section
Display the settings section for the 
active window.

Image

Zoom In
Zoom in on the image in the active 
window.

Zoom Out
Zoom out from the image in the 
active window.

Selection Cursor
Select the crop cursor.

Zoom Cursor
Select the zoom cursor.

Hand Cursor
Select the hand cursor.

Show Grid
Display or hide the layout grid in 
the active window.

Windows

View

Toolbar
Display or hide the toolbar.

Status Bar
Display or hide the status bar.

Tool palettes
A list of Tool Chests is displayed in 
the View menu.  Select to display 
or hide Tool Chests.

Progress Window
Select to display or hide the prog-
ress window.
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Window

Fit To Screen
Resize the active window to fi t the 
screen.

Actual Size
View image in active window at 
100%.

Cascade
Arranges image windows so that 
they overlap.

Film Type

Select type of fi lm to be scanned.

Scan Color Space

Choose the scan color model.

Bit Depth

Choose the scan bit depth.

Transform

Rotate or fl ip the image in the 
preview area.

Windows

Scanner (displayed only when scan window is active)

Settings

Copy, save, load, delete, or reset 
settings for all tool palettes or for 
selected tool palettes.

Eject
Eject the fi lm or holder from the 
scanner.

Slide Feeder…
Choose the number of slides 
scanned when a slide feeder is 
inserted in the scanner.

Show Natural Pane /
Show Processed Pane
Switch between the “Natural” 
and “Processed” panels in the 
preview area.

Tools

Show Nikon Browser
Open the Nikon Browser compo-
nent of Nikon View.

Scanner/Firmware Version/Port
Open the scan window for the se-
lected scanner.

Window (continued)

Tile
Arranges image windows so that 
they do not overlap.

Arrange Icons
Arranges minimized image win-
dows along the bottom of the 
Nikon Scan application window.

Open windows
A list of the images currently open 
is displayed at the end of the Win-
dow menu.

Help

Help Topics
Open Nikon Scan help.

About Nikon Scan…
Display version information for 
Nikon Scan.
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Paste
Paste the contents of the clip-
board.

Clear
When entering text in a dialog, 
clear the contents of the current 
text box.

Select All
When entering text in a dialog, se-
lect all the text in the current text 
box.  When the scan window is 
active, select all thumbnails in the 
thumbnail drawer.

Application menu

About Nikon Scan…
Display version information for 
Nikon Scan.

Preferences…
Display the “Preferences” dialog.

Quit Nikon Scan 4
Quit Nikon Scan.

File

New
This command can not be used.

Open…
Open an image fi le.

File (continued)

Close
Close the active window.

Save
Save the image in the active win-
dow.

Save As…
Save the image in the active win-
dow under a new name.

Revert
This command can not be used.

Page Setup…
Adjust printer settings.

Print…
Print the image in the active win-
dow.

Edit

Undo
Undo the preceding operation.

Cut
When entering text in a dialog, 
cut selected text and place it in 
the clipboard.

Copy
When entering text in a dialog, cut 
selected text to the clipboard.

Copy Settings…
Copy to the clipboard selected 
Tool Chest settings for the image 
in the active window.  A dialog will 
be displayed where the desired 
settings can be selected.

Copy All Settings
Copy to the clipboard all Tool 
Chest settings for the image in the 
active window.

Macintosh (Mac OS X)
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Macintosh (Mac OS X)

View

Zoom In
Zoom in on the image in the active 
window.

Zoom Out
Zoom out from the image in the 
active window.

Hand Cursor
Select the hand cursor.

Selection Cursor
Select the crop cursor.

Zoom Cursor
Select the zoom cursor.

Focus Cursor
Select the cursor used to choose 
the focus point.

Show Grid
Display or hide the layout grid in 
the active window.

Progress Monitor
Display the progress window.

Tool palettes
A list of Tool Chests is displayed at 
the end of the View menu.  Select 
to display or hide Tool Chests.

Image

Settings

Copy, save, load, delete, or reset 
settings for all tool palettes or for 
selected tool palettes.

Settings Section
Display the settings section for the 
active window.

Color Space

Convert the image in the active 
window to a new color space and 
bit depth.

Transform

Rotate or fl ip the image in the ac-
tive window.
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Scanner (displayed only when scan window is active)

Settings

Copy, save, load, delete, or reset 
settings for all tool palettes or for 
selected tool palettes.

Eject
Eject the fi lm or holder from the 
scanner.

Slide Feeder…
Choose the number of slides 
scanned when a slide feeder is 
inserted in the scanner.

Show Natural Pane /
Show Processed Pane
Switch between the “Natural” 
and “Processed” panels in the 
preview area.

Macintosh (Mac OS X)

Tools

Show Nikon Browser
Open the Nikon Browser compo-
nent of Nikon View.

Scanner/Firmware Version/Port
Open the scan window for the 
selected scanner.

Window (displayed only when 
image window is active)

Fit To Screen
Resize the active window to fi t the 
screen.

Actual Size
View image in active window at 
100%.

Open windows
A list of the images currently open 
is displayed at the end of the Win-
dow menu.

Help

Nikon Scan Help
Open Nikon Scan help.

Film Type

Select type of fi lm to be scanned.

Color Space

Choose the scan color model.

Bit Depth

Choose the scan bit depth.

Transform

Rotate or fl ip the image in the 
preview area.
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Macintosh (Mac OS 9)

Save As…
Save the image in the active win-
dow under a new name.

Revert
This command can not be used.

Page Setup…
Adjust printer settings.

Print…
Print the image in the active win-
dow.

Quit
Quit Nikon Scan.

Apple menu

About Nikon Scan…
Display version information for 
Nikon Scan.

File

New
This command can not be used.

Open…
Open an image fi le.

Close
Close the active window.

Save
Save the image in the active win-
dow.

File (continued) Edit

Copy All Settings
Copy to the clipboard all Tool 
Chest settings for the image in the 
active window.

Paste
Paste the contents of the clip-
board.

Clear
When entering text in a dialog, 
clear the contents of the current 
text box.

Select All
When entering text in a dialog, se-
lect all the text in the current text 
box.  When the scan window is 
active, select all thumbnails in the 
thumbnail drawer.

Preferences…
Display the “Preferences” dialog.

Undo
Undo the preceding operation.

Cut
When entering text in a dialog, 
cut selected text and place it in 
the clipboard.

Copy
When entering text in a dialog, cut 
selected text to the clipboard.

Copy Settings…
Copy to the clipboard selected 
Tool Chest settings for the image 
in the active window.  A dialog will 
be displayed where the desired 
settings can be selected.
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Macintosh (Mac OS 9)

Zoom In
Zoom in on the image in the active 
window.

Zoom Out
Zoom out from the image in the 
active window.

Hand Cursor
Select the hand cursor.

Selection Cursor
Select the crop cursor.

Zoom Cursor
Select the zoom cursor.

Focus Cursor
Select the cursor used to choose 
the focus point.

Image

Settings

Copy, save, load, delete, or reset 
settings for all tool palettes or for 
selected tool palettes.

Settings Section
Display the settings section for the 
active window.

Show Grid
Display or hide the layout grid in 
the active window.

Progress Monitor
Display the progress window.

Tool palettes
A list of Tool Chests is displayed at 
the end of the View menu.  Select 
to display or hide Tool Chests.

View

Color Space

Convert the image in the active 
window to a new color space and 
bit depth.

Transform

Rotate or fl ip the image in the ac-
tive window.
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Film Type

Select type of fi lm to be scanned.

Color Space

Choose the scan color model.

Bit Depth

Choose the scan bit depth.

Transform

Rotate or fl ip the image in the 
preview area.

Scanner (displayed only when scan window is active)

Macintosh (Mac OS 9)

Tools

Show Nikon Browser
Open the Nikon Browser compo-
nent of Nikon View.

Scanner/Firmware Version/Port
Open the scan window for the 
selected scanner.

Window (displayed only when 
image window is active)

Fit to Screen
Resize the active window to fi t the 
screen.

Actual Size
View image in active window at 
100%.

Open windows
A list of the images currently open 
is displayed at the end of the Win-
dow menu.

Settings

Copy, save, load, delete, or reset 
settings for all tool palettes or for 
selected tool palettes.

Eject
Eject the fi lm or holder from the 
scanner.

Slide Feeder
Choose the number of slides 
scanned when a slide feeder is 
inserted in the scanner.

Show Natural Pane /
Show Processed Pane
Switch between the “Natural” 
and “Processed” panels in the 
preview area.

Help

Nikon Scan Help
Open Nikon Scan help.
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The Show Nikon Browser option can only be used if Nikon 
View 6 has been installed from the supplied Nikon View 6 
CD.  If an earlier version of Nikon View is already installed on 
the computer, upgrade to Nikon View 6.

Selecting Show Nikon Browser in the Nikon Scan Tools 
menu opens the Nikon Browser component of Nikon View, 
where image fi les that have been saved to disk can be 
browsed, and selected images viewed, edited, and printed.  
For more information, see the Nikon View Reference Manual 
or Nikon View’s on-line help.

Nikon View
Browsing Images

  Browsing Images Created with Nikon ScanBrowsing Images Created with Nikon Scan
Some functions are not available when browsing images created with 
Nikon Scan.  Nikon View does not support BMP (Windows) or PICT (Ma-
cintosh).  Save fi les in TIFF or JPEG when using Nikon View.  Large fi les 
created with Nikon Scan may not display in slide shows.

  Color ManagementColor Management
For accurate color reproduction, choose the same color-space profi le in 
Nikon Scan and Nikon View.

  Product RegistrationProduct Registration
Nikon View 6 or later can be registered on-line.  See the Nikon View 
Reference Manual for more information.
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Scan Index
Index to Scanning Options

This section lists common scanning operations.  Click the links to view related sections of this manual.

Common Tasks

Operation

Open the scan window Starting Nikon Scan (  8)

Specify the fi lm type The Film Type Menu (  19)

Choose a color model The Color Model Menu (  20)

Choose a frame size (9000 ED/8000 ED only) The Frame Size Menu (  20)

Select frames for scanning The Thumbnail Drawer (  23)

Preview images before scanning
The Preview Button (  26)
The Preview Area (  27)

Scan images The Scan Button (  28)

Save images after scanning Image Windows—Saving Images (  109)

Rotate images Layout Tools (  33)

Zoom images in and out

Layout Tools (  33)
The Scan Window—The Zoom Buttons (  16)
Image Windows—Zoom (  112)

Select the area to be scanned (select a crop) Layout Tools (  33)

View information about a selection Information (  35)

Focus the scanner The Autofocus Button (  15)

Adjust exposure The Autoexposure Button (  16)
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Operation

Set image size and output resolution Crop (  36)

Image Size and Resolution

Image Enhancement

Operation

Automatically adjust brightness and saturation to produce a high-contrast image Scan Image Enhancer (  70)

Reduce the effects of dust and scratches Digital ICE4  Advanced—Digital ICE (  62)

Restore colors lost through fading Digital ICE4  Advanced—Digital ROC (  63)

Reduce the effects of fi lm grain Digital ICE4  Advanced—Digital GEM (  64)

Reveal details in highlights and shadows Digital ICE4  Advanced—Digital DEE (  65)

Adjust contrast in highlights, mid-tones, or shadows Curves (  41)

Adjust color balance in highlights, mid-tones, or shadows Curves (  41)

Adjust brightness, contrast, and color balance over the entire tone range Color Balance (  51)

Sharpen edges Unsharp Mask (  53)

Adjust brightness, color saturation, and hue LCH Editor (  56)

Adjust color balance by selectively adjusting exposure during scanning Analog Gain (  69)

Choose a scan bit depth (pixel data size) Scanner Extras—Pixel Data Size (  75)

Reposition thumbnails Scanner Extras—Strip Film Offset (  73)

Adjust scanner settings Scanner Extras (  71)

Reduce noise (9000 ED, 8000 ED, 5000 ED, 4000 ED only) Scanner Extras—Multi-Sample Scanning (  76)
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Batch Scanning, Automatic Processing, and Scan Window Settings

Operation

Reuse scan window settings The Settings Menu (  17)

Specify actions performed before and after a single image is scanned Preferences—Single Scan (  95)

Specify actions performed before, during, and after a batch scan Preferences—Batch Scan (  96)

Choose a default fi le format Preferences—File Saving (  99)

Specify actions performed when fi lm is inserted Preferences—Automatic Actions (  100)

Specify actions performed when an image is previewed Preferences—Preview Settings (  103)

Choose the number of slides in a batch scan (SF-210/SF-200 (S))
Batch Scans (  29)
Scanner Extras—Slide Feeder Scan (  76)

Miscellaneous

Operation

Adjust output for display on the current computer monitor Preferences—Gamma (  82)

Choose a color profi le for accurate color reproduction Preferences—Color Management (  84)

Choose where Nikon Scan stores temporary fi les Preferences—File Locations/Scratch Disks (  94)

Set target output levels for the white point, gray point, and black point Preferences—Advanced Color (  101)

Choose a color and spacing for the layout grid Preferences—Grid Settings (  105)

Ensure that colors are reproduced accurately on the monitor, between applications, 
and on different output devices

Preferences—Nikon Color Management (  78)
Preferences—Gamma (  82)
Preferences—Color Management (  84)
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Appendix AAppendix A
TroubleshootingTroubleshooting

If any problems are encountered with Nikon Scan, check the list below before contacting a Nikon rep re sen ta tive.

Problem Possible Cause

—

—

—

 4
—

Nikon Scan displays the error, “Nikon 
Scan was unable to fi nd any active

devices.”

• The scanner is turned off or not connected.  Connect the scanner as described in the scanner 
User’s Manual.

• The USB or IEEE 1394 (Firewire) interface is not correctly installed, or the device drivers are 
missing or corrupted.  See the manufacturer’s manual for de tails.

• The scanner device drivers are not correctly installed (Windows only).  See the scanner hard-
ware manual for details.

• Your computer does not meet the specifi cations given in the system re quire ments.
• Nikon Scan is not correctly installed.  Reinstall Nikon Scan as described in the scanner User’s 

Manual.

—
—

The host application does not
recognize the Nikon Scan plug-in

(Macintosh).

• The plug-in has not been copied to the application’s plug-ins folder.
• The application does not support Adobe Photoshop plug-ins.  Use a dif fer ent host applica-

tion.

—Film jams in the scanner. See the scanner User’s Manual for information on resolving jams.

 15
 15Images are out of focus.

• An autofocus operation was not performed before the image was scanned.
• The focus point requires adjustment.

 85

 87

 86

—
 16

—

Colors do not match the original.

• The monitor profi le chosen in the “Color Management” category of the “Preferences” dialog 
does not match the mon i tor.

• The CMYK profi le chosen in the “Color Management” category of the “Preferences” dialog 
does not match the printer.

• The RGB color-space profi le chosen in the “Color Management” category of the “Pref er -
enc es” dialog has too narrow a gamut (colors too vivid) or too wide a gamut (image lacks 
contrast).

• Curves (  41), color balance (  51), or LCH (  56) settings are incorrectly adjusted.
• Negative fi lm was scanned without an autoexposure operation.
• Monitor settings require adjustment.



133Appendices TOPAppendices— Appendix A

Problem Possible Cause

 85

 87

 86

 82

—

Images are too dark.

• The monitor profi le chosen in the “Color Management” category of the “Preferences” dialog 
does not match your mon i tor.

• The CMYK profi le chosen in the “Color Management” category of the “Preferences” dialog 
does not match the printer.

• The RGB color-space profi le chosen in the “Color Management” category of the “Pref er -
enc es” dialog has the wrong gamma value for your platform.

• You need to adjust the gamma value chosen in the “Gamma” category of the “Pref er enc es“ 
dialog for use when Nikon CMS is off.

• The brightness setting on your monitor requires adjustment.

 36
 53

The scanned image has a rough,
jagged appearance.

• The resolution setting in the “Crop” palette does not suit the output device.
• The halo width or intensity settings in the “Unsharp Mask” palette are too high.

 36File size is too large. The value for resolution in the “Crop” palette is too high.

 36Print size is too large or too small. “Crop” palette settings are not adjusted correctly.
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Appendix BAppendix B
GlossaryGlossary

This glossary provides defi nitions of some of the terms used in this manual.

Term Defi nition

Bit depth

The number of bits used to express color, also referred to as color depth.  The bit depth determines the amount of color infor-
mation in an image.  The greater the bit depth, the larger the number of colors, and the fi ner the gradations, that can be ex-
pressed.  Bit depth can be used to refer both to the number of bits per channel and to the combined bit depth for all channels; 
thus, for example, an image with a bit depth of eight bits per channel can be said to have a bit depth of twenty-four bits.  An 
image with a bit depth of one bit has only two colors, typically black and white, with no gradation between the two.  See also 
Channel.

Black point
The input value below which all input tones are mapped to the minimum output value (by default no color, or black).  Any de-
tails darker than the black point will be lost.  See also Tone, Tone curve.

Channel
The component colors in a given color space.  The RGB color space is made up of red, green, and blue channels and a master 
channel that combines the three.  See also Color space.

CMS See Color management system.

CMYK

A refl ective (subtractive) color model commonly used in printing, which models color using com bi na tions of the three second-
ary colors used in printer’s ink, Cyan, Magenta and Yellow.  Because no com bi na tion of these three inks will create a true black, 
blacK ink is also used.

Color
management

system

A method of ensuring consistency of color reproduction between devices such as scanners, monitors, and printers, and be-
tween different computer platforms.  In the color management system used in Nikon Capture 3, accurate color reproduction is 
ensured through the use of profi les that provide information about the characteristics of the monitor or printer and the color 
space used for editing.  See also ICC, Profi le.

Color space
A general term encompassing both the model used to defi ne color (for example, CMYK or RGB) and the range, or gamut, of 
colors that can be expressed in a given color model.  See also CMYK, Gamut, RGB.

Compression

A method for reducing fi le sizes for storage or transmission.  Compression algorithms can be divided into “lossless” algorithms, 
such as LZW, in which no information is lost when fi les are restored to their original size for display or editing, and “lossy” al-
gorithms, such as JPEG, in which some information is lost when the fi le is restored.  See also JPEG, TIFF.
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Term Defi nition

Crop The selected portion of an image.

Curve See Tone Curve.

dpi dots per inch, a measure of resolution.  The more dots per inch, the higher the resolution. See also ppi, Resolution.

Gamma

Gamma (also written “γ”), a fundamental property of video systems, determines the intensity of the output signal relative to 
the input.  When calculating gamma, the maximum possible input intensity is assigned a value of one, and the minimum pos-
sible intensity (no input) is assigned a value of zero.  Output is calculated by raising input to the inverse of the gamma value 
(output = input ( 1/γ) ).

Gamut

The range of colors that can be expressed by a given input device (for example, scanner or digital camera), output device (moni-
tor or printer), or color profi le.   No gamut can reproduce all of the colors seen by the human eye.  The gamut of primary RGB 
(Red, Green, and Blue) transmitted light displays (fi lm transparencies and color monitors) is very different from, and comple-
mentary to, the gamut of secondary CMYK (Cyan, Magenta, Yellow, and blacK) re fl ect ed light displays (printed materials).  See 
also CMYK, Profi le, RGB.

Halo width

The extent of pixels around a selected central pixel affected when Unsharp Mask is applied.  Also referred to as “radius.”  In-
creasing the halo width increases the width of edges affected by Unsharp Mask.  Excessive application of Unsharp Mask results 
in an undesirable halo along edges in the image.  See also Unsharp Mask.

Histogram

A bar graph showing the distribution of tones or chroma in an image.  The horizontal axis shows tone level (bright ness) or chro-
ma, the vertical axis the number of pixels.  The bars in the graph show the num ber of pixels of a given brightness or chroma in 
the image.  The histograms displayed in the “Curves” and “LCH Editor” palettes shows the distribution for the selected chan-
nel, and can be used for ref er ence when editing curves.  See also Tone, Tone curve.

ICC

The International Color Consortium, an international organization working to develop stan dards for color management and 
color management profi les.  ICC profi les were developed for the conversion of color space information between devices, and 
are now on their way to becoming a global standard.  ICC profi les have been proposed as an International Or ga ni za tion for 
Standardization (ISO) standard.  See also Profi le.

Gray point Controls the output level for mid-tones in the original image.  See also Tone, Tone curve.

Firewire Apple’s term for the IEEE 1394 interface.  See IEEE 1394.

Grayscale
A color model reproduces image data in shades of gray.  Eight-bit grayscale supports 256 shades, sixteen-bit grayscale 65,526 
shades.  See also Bit depth.
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JPEG

A standard graphic format designed by the Joint Photographic Experts Group.  Images are compressed using a discrete cosine 
transform that takes advantage of the properties of hu man vision, which is more sensitive to light in the lower wavelengths, 
to increase quantization at lower frequencies.  JPEG com pres sion is “lossy,” meaning that information is lost when images are 
compressed, leading to a drop in image quality.  A lossless compression option is also supported in some implementations.  
JPEG images can be compressed to as much as 100:1, though quality will be signifi cantly reduced.  At a compression ratio of 
20 : 1, image quality is not noticeably diminished.

Term Defi nition

NEF

Nikon Electronic Image Format, an image fi le format developed by Nikon to support high-resolution image data.  In Windows, 
NEF fi les have the ex ten sion “.nef”.  The advantage of NEF is that while user settings such as curves and color balance are saved, 
they are not applied to the original image data.  NEF images may thus be edited and saved several times without degrading or 
altering the original image.

Noise
Digital “artifacts,” or data in an image fi le that are not a part of the original image.  The presence of noise is refl ected in a loss 
in image quality.

ppcm
pixels per centimeter, a measure of resolution.  The more pixels per centimeter, the higher the res o lu tion. See also ppi, Reso-
lution.

ppi pixels per inch, a measure of resolution.  The more pixels per inch, the higher the resolution. See also ppcm, Resolution.

Preferences Settings controlling basic operations performed by a given program, adjustable by the user.

Profi le

A fi le defi ning the color characteristics of an input device such as a scanner or digital camera, an output device such as a printer 
or monitor, or the color space used for editing images.  Profi les are used by color management systems to ensure consistent col-
or reproduction.  The Nikon Color Management System used in Nikon Scan employs ICC profi les.  See also Color space, ICC.

Resolution

The density of dots or pixels that make up an image, measured in dots per inch (dpi) or pixels per inch (ppi); the resolution of 
Windows monitors, for example, is 96 ppi.  The greater the density of dots or pixels, the higher the resolution and the greater 
the capacity to express detail.  Resolution is hence the digital equivalent of fi lm resolving power.  Computer monitors typically 
have a resolution of 72 ppi, 90 ppi, or 96 ppi, while printers may have resolutions of 300 dpi, 600 dpi, 1200 dpi, or 2400 dpi.  See 
also ppcm, ppi.

Plug-in A software module that adds functionality to another application.

IEEE 1394
A high-speed transfer protocol developed by the Institute of Electrical and Electronics En gi neers for connecting peripherals such 
as hard disks, MO drives, and digital cameras to a com put er via a cable.
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Scale The output size of an image as a percentage of the input size.  At a scale of 50%, images are output at half their original size.

RGB
An additive color model commonly used in monitors, in which light emitted in three primary colors, Red, Green and Blue, is 
combined to create a wide variety of colors.  White is modeled by mixing 100% of all three colors.

Term Defi nition

Thumbnail
A small preview image, the digital equivalent of a photographic fi lm contact sheet.  If the current adapter can read multiple 
frames, thumbnails will be displayed in the scan windows thumbnail drawer.

Threshold

The limit up to which Unsharp Mask will be applied.  While it is generally the case that the higher the threshold, the greater the 
amount of sharpening applied, the exact effect depends on other Unsharp Mask settings, such as halo width.  See also Halo 
width, Unsharp Mask.

Tone

Pixel brightness, measured either as the combined intensity for red, green, and blue or the intensity of each of these colors 
(channels) individually.  The number of tones that can be expressed depends on the bit depth of the image.  The distribution of 
tones in the image can be seen in the “Curves” palette histogram.  See also Bit depth.

TIFF

Tagged Image File Format, an image fi le format for color or grayscale images, suited to storing bit-mapped images such as 
digital photographs.  In some implementations, TIFF supports “lossless” LZW and packbit compression (in “lossless” compres-
sion methods, no information is lost when the image is compressed, as opposed to “lossy” compression methods such as JPEG, 
in which detail is sacrifi ced to achieve higher compression ratios).  Images saved in TIFF format using Nikon Scan are not com-
 pressed.  See also Compression, JPEG.

TWAIN
A standard for input devices such as scanners and digital cameras.  Applications that support TWAIN can acquire data from and 
TWAIN-compliant device.

Tone curve

A visual tool for editing tones, enhancing brightness and contrast in a selected portion of the tone range.  Changing the shape 
of the tone curve changes the mapping between input (the tones in the original image) and output (tones as they appear after 
editing).  The digital equiv a lent of a densitometric curve.  See also Tone.

USB
Universal Serial Bus.  A standard for computer serial interfaces which allows automatic “plug-and-play” recognition of periph-
eral devices and “hot plug” connection of peripherals while the computer or device is on.

Unsharp Mask

A fi lter for increasing the apparent sharpness of bit-mapped images.  Sometimes abbreviated as “USM.” Unsharp masks em-
phasize the differences in color and brightness between edges (outlines) and the rest of the image.  See also Halo width, 
Threshold.

White point
The input value above which all input tones are mapped to the maximum output value (the default for the master channel is 
white).  Any details brighter than the white point will be lost.  See also Tone, Tone curve.
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Appendix CAppendix C
Memory Requirements (Mac OS 9 Only)Memory Requirements (Mac OS 9 Only)

Under Mac OS 9, the amount of memory required for best performance varies with the scanner used.  The following table 
lists the total system memory needed for full use of all scanner functions, together with the recommended memory alloca-
tion for Nikon Scan when used as a “stand-alone” application.  Use these values as a guide when entering the preferred 
memory size (  139).

Memory allocation (“preferred size”)Total memoryScanner

5000 ED / COOLSCAN V ED† 450 MB1 GB or more

4000 ED / COOLSCAN IV ED† 450 MB768 MB or more

9000 ED/8000 ED* 800 MB1.5 GB or more

* Memory required when scanning 6 × 9 medium-format fi lm at full size using FH-869S fi lm holder with Digital DEE (9000 ED only), Digital ICE, 
Digital ROC, and Digital GEM.

† Memory required when scanning forty frames using optional IA-20 (S) or SA-30 adapter (5000 ED, 4000 ED) or six frames using SA-21 (COOLS-
CAN V ED, COOLSCAN IV ED) with Digital DEE (5000 ED and COOLSCAN V ED only), Digital ICE, Digital ROC, and Digital GEM.  Assumes all 
frames are previewed and scanned at full size.

Turn virtual memory off when using Nikon Scan.  To turn virtual memory off, quit all applications, open the Memory control 
panel, select Off for “Virtual Memory,” and restart the computer.
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Allocating Memory to the Host Application

1. After making sure the host application is not running, open the application folder and click the host application icon once 
to select it.  To allocate more memory to Nikon Scan when it is used as a “stand-alone” application, open the “Nikon 
Software : Nikon Scan 4” folder in the install location (the default installation folder is the “Applications” folder on the 
start-up disk) and click the Nikon Scan icon.

2. Select Get Info (  I) from the Finder File menu.  The application info dialog 
will be displayed.

3. Select Memory from the Show menu.

4. Consult the table on the previous page and enter the appropriate value for 
“Preferred size.”
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